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¢ For safety and warning information, please read this
manual before attempting to use the equipment.

e Additional safety and warning information is provided
within the MG3700A Vector Signal Generator
Operation Manual (Mainframe), MG3710A Vector
Signal Generator MG3740A Analog Signal Generator
Operation Manual (Mainframe),
MS2690A/MS2691A/MS2692A Signal Analyzer
Operation Manual (Mainframe Operation), or
MS2830A Signal Analyzer Operation Manual
(Mainframe Operation). Please also refer to either of
these documents before using the equipment.

e Keep this manual with the equipment.
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Safety Symbols

To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu Corporation uses the
following safety symbols to indicate safety-related information. Ensure that you clearly understand the meanings
of the symbols BEFORE using the equipment. Some or all of the following symbols may be used on all Anritsu
equipment. In addition, there may be other labels attached to products that are not shown in the diagrams in this
manual.

Symbols used in manual

f DANGER This indicates a very dangerous procedure that could result in serious injury or
death if not performed properly.

A WA R N | N G This indicates a hazardous procedure that could result in serious injury or death if

not performed properly.

A CA UTION This indicates a hazardous procedure or danger that could result in light-to-severe
injury, or loss related to equipment malfunction, if proper precautions are not taken.

Safety Symbols Used on Equipment and in Manual

The following safety symbols are used inside or on the equipment near operation locations to provide information
about safety items and operation precautions. Ensure that you clearly understand the meanings of the symbols
and take the necessary precautions BEFORE using the equipment.

This indicates a prohibited operation. The prohibited operation is indicated
symbolically in or near the barred circle.

indicated symbolically in or near the circle.

This indicates a warning or caution. The contents are indicated symbolically in or
near the triangle.

O This indicates an obligatory safety precaution. The obligatory operation is

This indicates a note. The contents are described in the box.

% E These indicate that the marked part should be recycled.
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Equipment Certificate

Anritsu Corporation guarantees that this equipment was inspected at
shipment and meets the published specifications.

Anritsu Warranty

e During the warranty period, Anritsu Corporation will repair or exchange
this software free-of-charge if it proves defective when used as described
in the operation manual.

e The warranty period is 6 months from the purchase date.

e The warranty period after repair or exchange will remain 6 months
from the original purchase date, or 30 days from the date of repair or
exchange, depending on whichever is longer.

e This warranty does not cover damage to this software caused by Acts
of God, natural disasters, and misuse or mishandling by the customer.

In addition, this warranty is valid only for the original equipment

purchaser. It is not transferable if the equipment is resold.

Anritsu Corporation will not accept liability for equipment faults due to
unforeseen and unusual circumstances, nor for faults due to mishandling

by the customer.

Anritsu Corporation Contact

In the event that this equipment malfunctions, contact an Anritsu
Service and Sales office. Contact information can be found on the last
page of the printed version of this manual, and is available in a separate

file on the CD version.
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Notes On Export Management

This product and its manuals may require an Export License/Approval by
the Government of the product's country of origin for re-export from your
country.

Before re-exporting the product or manuals, please contact us to confirm
whether they are export-controlled items or not.

When you dispose of export-controlled items, the products/manuals need
to be broken/shredded so as not to be unlawfully used for military purpose.




Software End-User License Agreement (EULA)

Please read this Software End-User License Agreement (hereafter this EULA) carefully before using

(includes executing, copying, registering, etc.) this software (includes programs, databases, scenarios,

etc., used to operate, set, etc., Anritsu electronic equipment). By reading this EULA and using this

software, you are agreeing to be bound by the terms of its contents and Anritsu Corporation (hereafter

Anritsu) hereby grants you the right to use this Software with the Anritsu-specified equipment

(hereafter Equipment) for the purposes set out in this EULA.

1.

Grant of License and Limitations

. Regardless of whether this Software was

purchased from or provided free-of-charge by
Anritsu, you agree not to rent, lease, lend, or
otherwise distribute this Software to third

parties and further agree not to disassemble,
recompile, reverse engineer, modify, or create

derivative works of this Software.

. You may make one copy of this Software for

backup purposes only.

. You are not permitted to reverse engineer

this software.

. This EULA allows you to install one copy of

this Software on one piece of Equipment.
Disclaimers

To the extent not prohibited by law, in no
event shall Anritsu be liable for personal
injury, or any incidental, special, indirect or
consequential damages whatsoever,
including, without limitation, damages for
loss of profits, loss of data, business
interruption or any other commercial
damages or losses, arising out of or related

to your use or inability to use this Software.

Limitation of Liability

. If a fault (bug) is discovered in this Software,

preventing operation as described in the
operation manual or specifications whether
or not the customer uses this software as
described in the manual, Anritsu shall at its
own discretion, fix the bug, or exchange the
software, or suggest a workaround,
free-of-charge. However, notwithstanding
the above, the following items shall be
excluded from repair and warranty.

1) If this Software is deemed to be used for
purposes not described in the operation
manual or specifications.

ii) If this Software is used in conjunction with
other non-Anritsu-approved software.

iii) Recovery of lost or damaged data.

iv) If this Software or the Equipment has been
modified, repaired, or otherwise altered
without Anritsu's prior approval.

v) For any other reasons out of Anritsu's direct
control and responsibility, such as but not
limited to, natural disasters, software virus

infections, etc.

b. Expenses incurred for transport, hotel, daily

allowance, etc., for on-site repairs by Anritsu
engineers necessitated by the above faults

shall be borne by you.

. The warranty period for faults listed in

article 3a above covered by this EULA shall
be either 6 months from the date of purchase
of this Software or 30 days after the date of

repair, whichever is longer.



4. Export Restrictions

You may not use or otherwise export or
re-export directly or indirectly this Software
except as authorized by Japanese and
United States law. In particular, this
software may not be exported or re-exported
(a) into any Japanese or US embargoed
countries or (b) to anyone on the Japanese or
US Treasury Department's list of Specially
Designated Nationals or the US Department
of Commerce Denied Persons List or Entity
List. By using this Software, you warrant
that you are not located in any such country
or on any such list. You also agree that you
will not use this Software for any purposes
prohibited by Japanese and US law,
including, without limitation, the
development, design and manufacture or
production of missiles or nuclear, chemical or

biological weapons of mass destruction.

Termination

Anritsu shall deem this EULA terminated if
you violate any conditions described herein.
This EULA shall also be terminated if the
conditions herein cannot be continued for
any good reason, such as violation of
copyrights, patents, or other laws and
ordinances.

Reparations

If Anritsu suffers any loss, financial or
otherwise, due to your violation of the terms
of this EULA, Anritsu shall have the right to
seek proportional damages from you.
Responsibility after Termination

Upon termination of this EULA in
accordance with item 5, you shall cease all
use of this Software immediately and shall
as directed by Anritsu either destroy or
return this Software and any backup copies,
full or partial, to Anritsu.

Dispute Resolution

If matters of dispute or items not covered by
this EULA arise, they shall be resolved by
negotiations in good faith between you and
Anritsu.

Court of Jurisdiction

This EULA shall be interpreted in
accordance with Japanese law and any
disputes that cannot be resolved by
negotiation described in Article 8 shall be

settled by the Japanese courts.



Cautions against computer virus infection

Copying files and data

Only files that have been provided directly from Anritsu or generated
using Anritsu equipment should be copied to the instrument.

All other required files should be transferred by means of USB or
CompactFlash media after undergoing a thorough virus check.
Adding software

Do not download or install software that has not been specifically
recommended or licensed by Anritsu.

Network connections

Ensure that the network has sufficient anti-virus security protection in
place.
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Protection Against Computer Virus Infections

Prior to the software installation

Before installing this software or any other software recommended or
approved by Anritsu, run a virus scan on your computer, including
removable media (e.g. USB memory stick and CF memory card) you
want to connect to your computer.

When using this software and connecting with the measuring instrument
e Copying files and data
On your computer, do not save any copies other than the following:
e Files and data provided by Anritsu
e Files created by this software
e Files specified in this document
Before copying these files and/or data, run a virus scan, including
removable media (e.g. USB memory stick and CF memory card).
e Connecting to network
Connect your computer to the network that provides adequate
protection against computer viruses.

Cautions on Proper Operation of Software

This software may not operate normally if any of the following operations

are performed on your computer:

e Simultaneously running any software other than that recommended or
approved by Anritsu

e Closing the lid (Laptop computer)

e Turning on the screen saver function

e Turning on the battery-power saving function (Laptop computer)

For how to turn off the functions, refer to the operation manual that came

with your computer.




CE Conformity Marking

Anritsu affixes the CE conformity marking on the following product(s) in
accordance with the Council Directive 93/68/EEC to indicate that they
conform to the EMC and LVD directive of the European Union (EU).

CE marking

1. Product Model
Software: MX370101A/MX269901A HSDPA/HSUPA IQproducer™

2. Applied Directive and Standards
When the MX370101A/MX269901A HSDPA/HSUPA IQproducer™ is
installed in the MG3710A, MS2690A/MS2691A/MS2692A, or MS2830A,
the applied directive and standards of this software conform to those of

the MG3710A, MS2690A/MS2691A/MS2692A, or MS2830A main frame.

PS: About main frame
Please contact Anritsu for the latest information on the main frame
types that MX370101A/MX269901A can be used with.
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C-tick Conformity Marking

Anritsu affixes the C-tick mark on the following product(s) in accordance with
the regulation to indicate that they conform to the EMC framework of
Australia/New Zealand.

C-tick marking

CN274

1. Product Model
Software: MX370101A/MX269901A HSDPA/HSUPA IQproducerTM

2. Applied Directive and Standards
When the MX370101A/MX269901A HSDPA/HSUPA IQproducerTNI is
installed in the MG3710A, MS2690A/MS2691A/MS2692A, or MS2830A,
the applied directive and standards of this software conform to those of
the MG3710A, MS2690A/MS2691A/MS2692A, or MS2830A main frame.

PS: About main frame
Please contact Anritsu for the latest information on the main frame
types that MX370101A/MX269901A can be used with.



About This Manual

m Associated Documents
The operation manual configuration of the MX370101A/MX269901A

HSDPA/HSUPA 1Qproducer™ is shown below.

m If using MG3700A or MG3710A:

MG3700A MG3710A Vector Signal Generator
Vector Signal Generator 4= | \/\G3740A Analog Signal Generator
Operation Manual (Mainframe) Or Operation Manual (Mainframe)

MG3700A /MG3710AVector Signal Generator
| MG3740A Analog Signal Generator Operation Manual (IQproducer™)

MX370101A/MX269901A
HSDPA/HSUPA IQproducer™ Operation Manual

e MG3700A Vector Signal Generator Operation Manual (Mainframe)
This describes basic operations, maintenance procedure, and remote
functions of the MG3700A Vector Signal Generator.
I Or

e MG3710A Vector Signal Generator MG3740A Analog Signal Generator

Operation Manual (Mainframe)
This describes basic operations, maintenance procedure, and remote
functions of the MG3710A Vector Signal Generator and the MG3740A
Analog Signal Generator .

e MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal
Generator Operation Manual (IQproducer™)

This describes the functions and how to use the IQproducer, which is

Windows software for the Vector Signal Generator and the Analog Signal

Generator .

e HSDPA/HSUPA IQproducer™ Operation Manual (This document)

This describes basic operations and functions of the HSDPA/HSUPA

IQproducer™.
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m If using MS2690A/MS2691A/MS2692A or MS2830A:

MS2690A/MS2691A/MS2692A
Signal Analyzer Operation Manual
(Main Frame Operation)

MS2830A Signal Analyzer

“ Operation Manual

Or (Main Frame Operation)

MS2690A/MS2691A/MS2692A and MS2830A
Signal Analyzer Operation Manual (Main Frame Remote Control)

MS2690A/MS2691A/MS2692A
Signal Analyzer Option 020:
Vector Signal Generator

MS2830A
Signal Analyzer
Vector Signal Generator

Operation Manual Or Operation Manual
(Operation) (Operation)
MS2690A/MS2691A/MS2692A MS2830A Signal Analyzer
Signal Analyzer Option 020: “ Vector Signal Generator
Vector Signal Generator Operation Manual
Operation Manual Or (Remote Control)
(Remote Control)

MS2690A/MS2691A/MS2692A and MS2830A
Vector Sianal Generator Operation Manual (IQproducer™)

MX370101A/MX269901A

HSDPA/HSUPA IQproducer™ Operation Manual




o MS2690A/MS2691A/MS2692A Signal Analyzer Operation Manual (Main-
frame, Operation)

This describes basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2690A/MS2691A/MS2692A.
I Or

o MS2830A Signal Analyzer Operation Manual (Mainframe, Operation)
This describes basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2830A.

o MS2690A/MS2691A/MS2692A and MS2830A Signal Analyzer Operation
Manual (Mainframe, Remote Control)

These describe basic operations, maintenance procedure, common func-

tions and common remote functions of the MS2690A/MS2691A/MS2692A

or MS2830A.

o MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector Signal
Generator Operation Manual, Operation
This describes the functions and how to use the Vector Signal Generator

IOr

o MS2830A Vector Signal Generator Operation Manual, Operation

This describes the functions and how to use the Vector Signal Generator

option.

option.

o MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector Signal
Generator Operation Manual, Remote Control
This describes how to remotely control the Vector Signal Generator op-

IOr

o MS2830A Vector Signal Generator Operation Manual, Remote Control

tion.

This describes how to remotely control the Vector Signal Generator op-

tion.

e MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator
Operation Manual (IQproducer™)
This describes the functions and how to use the IQproducer, which is

Windows software for the Vector Signal Generator option.

o HSDPA/HSUPA IQproducer™ Operation Manual (This document)

This describes basic operations and functions of the HSDPA/HSUPA

IQproducer™.
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Chapter 1 Overview

This chapter provides an overview of the MX370101A/MX269901A
HSDPA/HSUPA 1Qproducer™,

1.1 Product OVEIVIEW ......coveeieeeeeeeeeeeeee e 1-2
1.2 Product Composition ..........ccceeeeeiiiiiiiiieeee e 1-3
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Chapter 1 Overview

1.1 Product overview
MX370101A/MX269901A HSDPA/HSUPA IQproducer™ (hereinafter

referred to as “this software”) is software used to generate waveform
patterns conforming to the 3GPP HSDPA/ HSUPA specifications.

This software requires either of the following environment:

e MG3710A Vector Signal Generator
o MS2690A/MS2691A/MS2692A or MS2830A Signal Analyzer with
Vector Signal Generator option mounted

e Personal computer (hereinafter, “PC”)

This software generates waveform patterns that support the
specifications of 3GPP HSDPA/HSUPA with various characteristics. This
is made possible by the editing/customizing of parameters according to
its use.

A waveform pattern created by this software can be output using an RF
signal after being downloaded into the MG3700A Vector Signal

Generator , MG3710A Vector Signal Generator , or an
MS2690A/MS2691A/MS2692A or MS2830A Signal Analyzer with Vector
Signal Generator option installed (collectively referred to as “mainframe”,
or “this equipment”).




1.2  Product Composition

1.2 Product Composition

The following table lists the model name and specifications of this

software according to the equipment.

Table 1.2-1 Restrictions
Mainframe MS2690A
MG3700A MG3710A MS2691A MS2830A
e MS2692A
Restrictions
Software name MX370101A MX269901A
. . 64 M sample
Maximum Size
256 M sample 128 M sample*s 64 M sample
of Waveform 512 M sample™! 256 M sample*® 256 M sample 256 M sample*+
Patterns .
512 M sample®?
;r:&st)lglz?on LAN, External device USB Memory and | USB Memory and
CompactFlash such as LAN, USB | other external other external
Waveform Card . device™ device™
Patterns ar memory evice evice
Installation of
this software to | N/A Possible Possible*s Possible*s

this equipment

*1:

*2:

*3:

*4:

*5:

*6:

The ARB memory expansion 512M sample (optional) must be

installed into the MG3700A to use waveform patterns that exceed

256 M samples.

Transferring waveform patterns is not required if the waveform

patterns are created on the equipment using this software.

Although this software can be installed and run in the
MS2690A/MS2691A/MS2692A or MS2830A, the measurement
functions of the MS2690A/MS2691A/MS2692A or MS2830A are not

guaranteed while this software runs.

The ARB memory expansion 256M sample (optional) must be

installed into the Vector Signal Generator option to use waveform

patterns that exceed 64 M samples.

The Combination of Baseband Signal (optional) must be installed

into the MG3710A to use waveform patterns of maximum 128 M

samples.

The ARB memory expansion 256M sample (optional) must be

installed into the MG3710A to use waveform patterns of maximum

256 M samples.
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Chapter 1 Overview

*7: To use waveform patterns of maximum 512 M samples, either of the
following must be installed into MG3710A:

e ARB memory expansion 1024 M sample (optional)

e ARB memory expansion 256 M (optional) and Combination of
Baseband Signal (optional)

m Notes on waveform pattern conversion

The waveform patterns generated with this software varies according to
the main unit type. If using the waveform pattern to the different main
unit, you need to convert the waveform pattern.

For details about how to convert a waveform pattern, refer to each one of
the following manuals.

e MG3700A/MG3710A Vector Signal Generator MG3740A Analog
Signal Generator Operation Manual (IQproducer™)
4.5 “File Conversion on Convert Screen”

e MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator
Operation Manual (IQproducer™)
4.5 “File Conversion on Convert Screen”




Chapter 2 Preparation

This chapter describes the operating environment for the

MX370101A/MX269901A.
2.1 Operating Environment...........ccccoooeiiiiininiiene e 2-2
2.2 Installation/Uninstallation ............ccccceiiiiniininennnee, 2-3
2.3  Starting up and exiting the software .......................... 2-4
2.3.1 Starting Software: When installed -
on other than MG3710A .........cocceovveivrcennnne 2-4 =
2.3.2 Starting Software: When installed §
ON MG3710A ..o 2-6 =4
2.3.3 Exiting Software...........ccccceeeeiiiiiiiiieeee e, 2-7 g.




Chapter 2 Preparation

2.1 Operating Environment

The following environment is required for operating the
MX370101A/MX269901A.

(1) PC that meets the following conditions

(ON]

Windows XP/Windows Vista/Windows 7

CPU

Pentium III 1 GHz equivalent or faster

Memory

512 MB or more

Hard disk space

5 GB or more free space in the drive where
this software is to be installed.

The free hard disk space necessary to create
waveform pattern varies depending on the
waveform pattern size. The free disk space of
27 GB or greater is required to create four
maximum (512 Msample) waveform patterns.

(2) If viewing on PC, displays with a resolution of 1024 x 768 pixels are

best viewed using a small font setting.




2.2 Installation/Uninstallation

2.2 Installation/Uninstallation

This software is included in the IQproducer™ installer. It is
automatically installed by installing the IQproducer™ that is supplied
with this equipment or this software. When using a waveform pattern
created using this software in the equipment, the license file must be

installed in advance.

m Installing/Uninstalling IQproducer™
For how to install and uninstall IQproducer™, refer to each of the
following manuals:

o MG3700A/MG3710A Vector Signal Generator MG3740A Analog
Signal Generator Operation Manual (IQproducer™)
Chapter 2 “Installation”

o MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator
Operation Manual (IQproducer™)
Chapter 2 “Installation”
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m Installing/Uninstalling IQproducer™ license file
For how to install license file to MG3700A/MG3710A, refer to the

following manual:

e MG3700A/MG3710A Vector Signal Generator MG3740A Analog
Signal Generator Operation Manual (IQproducer™)
5.1 “Installing License File”

For how to uninstall license file from MG3700A/MG3710A, refer to each
one of the following manuals:

e MG3700A Vector Signal Generator Operation Manual (Mainframe)
3.10.10 “Install”

e MG3710A Vector Signal Generator MG3740A Analog Signal
Generator Operation Manual (Mainframe)
9.4.4 “Install”

Refer to the following manual for details of how to install/uninstall
license file to MS2690A/MS2691A/MS2692A or MS2830A with Vector
Signal Generator option.

o MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator
Operation Manual (IQproducer™)
2.2 “Installation/Uninstallation”




Chapter 2 Preparation

2.3 Starting up and exiting the software

This section explains how to start and stop this software.

Note:
The following explanation assumes the use of Windows XP. The
screen image may differ slightly if not using Windows XP.

2.3.1 Starting Software: When installed on other than MG3710A

Start this software using the following procedure.
The example assumes that it is a PC operation.

<Procedure>

1. Click Start on the task bar, and point to All Programs. Next, point to
Anritsu Corporation, point to IQproducer, and then click
IQproducer.

2. When IQproducer™ starts, the Select instrument screen is
displayed.
On the Select instrument screen, select the model of the main unit
that uses the waveform patterns created by IQproducer™.

Notes:
e The software does not support MG3740A.

e To hide this screen and to start with the selected mainframe's
screen from the next time, select the Don't show this window

next time check box.




2.8 Starting up and exiting the software

3. The common platform screen is displayed when OK is clicked in the
Select instrument screen.

The common platform screen is a screen used to select each function

™
of the IQproducer™.
A aproducer for WGI700 EEE
System(Cellular) System{Non-Cellular) General Purpose Simulation & Utility ‘
g HSDPA HSDPAg TD-
| (FoD b /HSUPAS: /HS}‘J A SCD!
| e £ %
LTEFDD LTE TDD HSDPA/HSUPA HSDPA/HSUPA Uplink TD-SCDMA
Downlink
W-COMA W-COMA @Ia D HS,
Downlink; UplinkiPs D 5
& L Y i) A
W-CDMA Downlink 'W-CDMA Uplink 1xEVDO FWD 1XEVDO RVS XG-PHS
(Standard) (Standard)
Change Instrument l HELP ‘ EXIT

Figure 2.3.1-1 Common Platform Screen

4. Click the System (Cellular) tab on the common platform screen, to

show the System (Cellular) selection screen that supports each
telecommunication system.

A Hproducer for MG3700

System(Cellular) ‘ System(Non-Cellular)

General Purpose

Simulation & Utiity ‘

[ iy ”
D ) 5 SCD)
TE L EE| e

LTEFDD LTE TDD HSDPA/HSUPA ISDPA/HSUPA Upli TD-SCDMA
Downlink

W-CDMA. D 15,
Llpllpy'r‘s VD A
) Al Bl ol
W-CDMA Downlink W-CDMA Uplink 1XEVDO FWD 1XEVDO RVS XG-PHS
(Standard) (Standard)
Change Instrument [ HELP ‘ EXIT ‘

Figure 2.3.1-2 System (Cellular) Selection Screen

5. Click HSDPA/HSUPA Downlink or HSDPA/HSUPA Uplink to
display the main screen. For details of the main screen, refer to
Chapter 3 “Detailed Description of Functions”.

Note:

If Change Instrument is clicked, the Select instrument screen will
appear each time the software is loaded.

25
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Chapter 2 Preparation

2.3.2 Starting Software: When installed on MG3710A

Start this software using the following procedure.

<Procedure>

1. Press on the MG3710A front panel to display the common

platform screen.

The common platform screen is a screen used to select each function
of the IQproducer™.

i Iproducer for MG3710

System(Cellular) System(Non-Cellular) General Pupose

Simulation & Utility ’

‘ i e
D) D A 5 SCD)
v B &
LTE FDD LTE TDD HSDPA/HSUPA HSDPA/HSUPA Uplink TD-SCDMA
Downlink
W-CDMA IXEVDO, IXEVDO, H
Up!i:l% i RV
W-CDMA Downlink W-CDMA Uplink 1XEVDO FWD 1XxEVDO RVS XG-PHS
(Standard) (Standard)
Interface Settings HELP EXIT

Figure 2.3.2-1 Common Platform Screen

2. Click the System (Cellular) tab on the common platform screen, to
show the System (Cellular) selection screen that supports each

telecommunication system.

i 10producer for MG3710

System(Cellular) System(Non-Cellular) General Purpose Simulation & Utility ’
TD-
), D SCD)
e < o A
LTEFDD LTE TDD TD-SCDMA
W-COMA W-COMA [IKEVDO, IXEVDO, m
Downlink, UplinkePAy Fi RIS
o i
W-CDMA Downlink W-CDMA Uplink 1xEVDO FWD 1XEVDO RVS XG-PHS
(Standard) (Standard)
(\meﬂace Semngs\D HELP ‘ EXIT

v

Figure 2.3.2-2 System (Cellular) Selection Screen




2.8 Starting up and exiting the software

3. Click HSDPA/HSUPA Downlink or HSDPA/HSUPA Uplink to
display the main screen. For details of the main screen, refer to
Chapter 3 “Detailed Description of Functions”.

Note:

When this software is installed on MG3710A, Change Instrument
displays instead of Interface Settings. Clicking Interface Settings
displays the Interface Setting dialog box.

Interface Settings | d
'-g
[¢]
Row Socket Port Number 49152 g
H
[N
=
fd o
. @)
Wait Time 10 =}
ms
Default Ok Cancel

Figure 2.3.2-3 Interface Settings Dialog Box

Here, you can configure interface-related settings of IQproducer
and MG3710A. To return to factory defaults, click Default.

e  Row Socket Port Number

Sets Row Socket port number. Set the same value as that for
MG3710A.

e  Wait Time

Sets the wait time between commands.

2.3.3 Exiting Software

Stop this software using the following procedure.

m When exiting only this software

To exit only this software without closing the Common Platform screen,
or other IQproducer™ tools, do one of these below:

e Click the Exit button (@ on the tool bar.

e Select Exit from the File menu.

e Click the [X] button on the upper right screen.

Edit  Transfer & Sett

Select Qption »
Becall Parameter File
Save Parameter File
Exit

Figure 2.3.3-1 Exiting Software
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The operation of the three screen buttons is explained below.

Exit x|

Do wou want to save the changes?

ez | il |

Figure 2.3.3-2 Exit Confirmation Window

e Yes Saves current parameters to file and stops this
software.
¢ No Stops this software without saving current

parameters to file.

e Cancel or X] Cancels the process and returns to the main screen.

When stopping this software using the Yes button, the saved parameters
are read at the next start and reset for each parameter.

m When exiting entire IQproducer™ application

To exit all tools of IQproducer™ that are running, select Exit on the
Common Platform Screen. In this case, a dialog is displayed to confirm
stopping of each running tool.

7 I0producer for MG3700

System(Cellular) | System(Non-Cellular) | General Purpose

Simulation & Uty ‘

B B
) 3 SUPA 5@
|  TE] Podees P ‘4
LTE FDD LTE TDD HSDPAHSUPA  HSDPAIHSUPA Uplink TD-SCDMA
Downlink
!V'(DIM:\ L‘{V]I(DMA 1XEVDO, 1)\([ VDO, XG=RHS)
owlik: PNk li R
o A % %
W-CDMA Downlink W-CDMA Uplink 1xEVDO FWD 1XEVDO RVS XG-PHS

(Standard) (Standard)

Change Instrument

HELP ‘ ; EXIT ?

Figure 2.3.3-3 Exiting IQproducer™




Chapter 8 Detailed Description of Functions

This chapter provides detailed descriptions of this software.

Notes:
e The examples and screens used throughout this chapter are
based on the assumption that the IQproducer™ is activated
with the MG3700A.

e The MG3710A, MS2690A/MS2691A/MS2692A, and MS2830A

functions are described as notes in each item.

3.1 Downlink Setup Screen .........cccooieiiiiiiiiiieeeee 3-2
311 Main SCreen ... ..o 3-2 c?
3.1.2 Details of setting parameters on main g.
LS 1= o RO UUST 3-13 g
3.1.3 Details of setting parameters on Channel ]
Edit screen........ccoeeeeiiiiii e 3-28 g
3.1.4 Details of setting parameters on HSDPA 5
Edit SCreeN.......ceeeeeeeeeeeeeeeeeeee e 3-32 g-
3.1.5 Calculation screen............coccoveveceeeveerrennn. 3-36 g
3.1.6 Calculation & Load ..........ccccvveevveevcieecieenen. 3-37 ;
3.1.7 Calculation & Play ........cccccveiiiiiiiiniiiieiieen, 3-38 g
3.1.8 Saving/reading parameters ............ccccceevuneenn. 3-38 Q
3.1.9 Generating waveform pattern file ................... 3-41 g'
3.1.10 Auxiliary signal output..........ccccceeeriiiiiiienennn. 3-45 @
3.2 Uplink Setup SCreen ........cccceeeeiiiiieieiiiiiee e 3-46
3.2.1 Main SCreeN ........uviiiiieiiiiieeee e 3-46
3.2.2 Details of setting parameters on main
LS 1= o RO UUST 3-54
3.2.3 Details of setting parameters on Channel
Edit screen........ccoeeeeiiiiiii e 3-68
3.2.4 Details of setting parameters on HSUPA
Edit screen........cceeeeeeiiiii e 3-71
3.2.5 Details of setting parameters on Channel
Gain Setup SCreeN.........ccooevcciiiieiieeeeeeecie, 3-78
3.2.6 Calculation screen..........cccccveveveeeiiiciiieeneenn, 3-80
3.2.7 Calculation & Load .........cccceeevivviveeiniiieeneeen. 3-81
3.2.8 Calculation & Play .........ccccveiiiieiiiniieceiieen, 3-82
3.2.9 Saving/reading parameters ............cccceevunen.. 3-82
3.2.10 Generating waveform pattern file ................... 3-85
3.2.11 Auxiliary signal output..........ccccceeeiiiiiiiiennnnn. 3-88
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3.1 Downlink Setup Screen
3.1.1 Main screen

On common platform screen, click the System (Cellular) tab, and then
select HSDPA/HSUPA Downlink to display the main screen.

DPA Downlink IQproducer for MG3700

File Edit Easy Setup  Transfer Setting
Menu -~ : ‘ ‘
o | & o

G | 14 |

Tool buttons Simulation Link: Down Link Scrambling Code 1 =] Total Power: -263 dB Number of Frames = ¥ futo
GPIGH ON  ~| Power |-i000 a8
P-CGPGH ON  ~| Pomer [-1200 a8 P-SCH & 5-5GH Power: dB T
Total Power el et |
. PIH [oN =] Fomer [-TEO0 o) Gl |3 SF =
display

DFGH ON x| Pomer [-1200 48 ChCode [ Dats  |FMC12Zkbps  +

QOGNS ON | FPower -343dB ChGode 122/123/124/125/1#6/127 SF = 128 Type |6 Codes(ch=122-127) =

HS-SGGHI Power 71300 dB  Ch Code Data  |Coded -
N I P oN o+ Edit
ormalize rower He—pheHt P -t o—— e Data  |HS-DSGH -
button
H5-5CGH2 Power dB  Ch Code SF=1238 Data :l
OFF =
HS-PDSGH2 Power dB ChCode 2tof, SF=15 Data E|
HS-SGCH3 Power dB  Ch Code SF=128 Data
OFF
HS-PDSGH3 Power dB ChCode 2tof, SF=15 Data
i HE-SGCH4 P dB  Ch Cod SF=128
Status display | Sy P ode Dota [Godd o]
HS-P] H4 Power dB ChCode 2tof. SF=16 Data

Figure 3.1.1-1 Downlink main screen
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3.1 Downlink Setup Screen

m File menu
The File menu contains the following items.

Edit Easy Setup Transfer Setting

Select Cption With Option21 (Memaory 512M zamples)

Becall Parameter File & ‘Without Option21 (Memary 512M samples?

Sawve Parameter File e =1

Exit 1

Figure 3.1.1-2 File menu

e Select Option
Notes:

e This function is available only when MG83700, MG3710 or
MS2830 is selected in the Select instrument screen.

e ARB Memory Expansion (option) is not available for
MS269xA. Only Memory 256M samples, 1 GB is available.

m When using MG3700A or MS2830A

Select whether the ARB memory expansion option 256Msamples is
installed. Selecting With Option21 (Memory 512M samples)/With
Option27 (Memory 256M samples) supports creation of larger
waveform patterns. If the ARB memory expansion option is not
installed, the generated waveform pattern may not be able to be
used. Waveform patterns cannot be created with a size greater than
256Msamples or 64M samples when Without Option21 (Memory
512M samples)/Without Option27 (Memory 256M samples) is
selected. Select either according to the presence of ARB memory
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expansion option.

Table 3.1.1-1 Available Options for MG3700A or MS2830A

Model Items ARB Men.10ry
Expansion
With Option21 (Memory 512M |1 GB x 2
samples) memory
MG3700A
Without Option21 (Memory 512 MB x 2
512M samples): Memories
With Option27 (Memory 256M
samples) 1GB
MS2830A
Without Option27 (Memory 956 MB
256M samples)
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m When using MG3710A

The presence/absence of the ARB Memory Expansion (option) and
Baseband Signal Combination Function (option) is selected.
Selecting the ARB Memory Expansion (option) and the Baseband
Signal Combination Function (option) generates a bigger waveform
pattern, while selecting the Baseband Signal Combination Function
(option) generates a waveform pattern. If an uninstalled option is
selected, sometimes the created waveform pattern may not be
usable.

Set the combination of installed options based on the following
setting items.

Table 3.1.1-2 Available Options for MG3710A

Items Combinations of Options

Memory 64M samples None

Option48
Memory 64M samples X 2 and
Option 78

Option45
Memory 256M samples or
Option 75

Option 45 and Option 48
Memory 256M samples X 2 or
Option 75 and Option 78

Option46
Memory 1024M samples or
Option 76

Option 46 and Option 48
Memory 1024M samples X 2 or
Option 76 and Option 78

The maximum size of the generated waveform pattern for each of
the setting items is shown below.

Table 3.1.1-3 Waveform Pattern Maximum Size

Items Maximum Size

Memory 64M samples 64M samples

Memory 64M samples x 2 (With
Option48, 78)

Memory 256M samples 256M samples

Memory 256M samples x 2 (With
Option48, 78)

Memory 1024M samples 512M samples

Memory 1024M samples x 2 (With
Option48, 78)

128M samples

512M samples

512M samples




3.1 Downlink Setup Screen

e Recall Parameter File
Sets the HSDPA/HSUPA Downlink parameters according to the

setting of the parameter files saved by Save Parameter File.

e Save Parameter File
Saves the HSDPA/HSUPA Downlink setting parameters to a file.

e Exit
Exits the HSDPA/HSUPA Downlink IQproducer™,

m Edit menu
The Edit menu contains the following items.

Zi Eazy Setup  Tranzfer Settir

Channel Edit
H=DPAL Edit

Caloculate Waveform Pattern

Figure 3.1.1-3 Edit menu
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e Channel Edit
Displays the Channel Edit screen in which the P-CCPCH and
DPCH parameters are set. This is the same operation with clicking
the Channel Edit button on the screen.

e HSDPA1 Edit, HSDPA2 Edit, HSDPA3 Edit, HSDPA4 Edit
Sets the channels related to HSDPA. This is the same operation
with clicking the Edit button on the screen.

e (Calculate Waveform Pattern
Starts waveform pattern generation based on the settings on the
screen.
The number of frames to be generated varies depending on the
setting conditions for each channel, and the time required for
generating a waveform pattern also varies accordingly. The number
of frames to be generated is displayed on the calculation progress

screen.
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When a waveform pattern is generated, two files with the
extensions “.wvi” and “.wvd” are created. When loading a waveform
pattern to a memory, select the *.wvi file for the target waveform
pattern.

When a waveform pattern that uses the FIR filter of the
MG3700A/MG3710A mainframe is created, a file with the extension
“-wvc” is created in addition to the *.wvi and *.wvd files. When
transferring a waveform pattern or loading a waveform pattern to a
memory, select the *.wvc file for the target waveform pattern. The

settings for two memories are executed at once by this operation.

For details of waveform pattern classification, refer to Appendix B
“Number of Frames to Be Generated”.

e C(Calculation & Load

Note:

This function is available only when this software is used on
MG3710A.

After waveform generation is finished, the created waveform
pattern is loaded into the MG3710A waveform memory.

e C(Calculation & Play

Note:

This function is available only when this software is used on
MG3710A.

After waveform generation is finished, the created waveform
pattern is loaded and selected at the MG3710A waveform memory.




3.1 Downlink Setup Screen

m Easy Setup menu
The Easy Setup menu contains the following item.

e H-Set (QPSK or 16 QAM)

H-Set 1{2PSE)
H-Set 10 6LANM)
H-Set 200P5K)
H-Set 20 6LANM)
) ) ) H-Set 3MPSKD
an Link: Dawn Link Scrambline H-Set 36 BOAM)

H-Set 4

0N * |  Power H-5et 5

Figure 3.1.1-4 H-Set (QPSK or 16QAM) menu

Selects the setting for each H-Set from HSDPA Fixed Reference
Channels (FRC) specified in 3GPP TS25.101.

Tables 3.1.1-4 and 3.1.1-5 list the parameters when each H-Set is
selected.

H-Set 1(QPSK)
H-Set 1(16QAM)
H-Set 2(QPSK)
H-Set 2(16QAM)
H-Set 3(QPSK)
H-Set 3(16QAM)
H-Set 4

H-Set 5
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Table 3.1.1-4 FRC H-Set common parameters
Parameter H-Set1, H-Set2, H-Set3, H-Set4, H-Set5
Scrambling Code 0
CPICH ON, -10dB
P-CCPCH ON, -12dB
P-SCH & S-SCH Power=—12 dB
PICH ON, -15dB, 2
DPCH ON, -13 dB, 8, RMC12.2 kbps
OCNS ON, 6 Codes (ch=122-127)
HS-SCCH1 ON, -13 dB, 9, Coded
HS-SCCH2 OFF, —40 dB, 0, Coded
HS-PDSCH2 -40 dB, HS-DSCH
HS-SCCH3 OFF, -40 dB, 0, Coded
HS-PDSCH3 -40 dB, HS-DSCH
HS-SCCH4 OFF, -40 dB, 0, Coded
HS-PDSCH4 -40 dB, HS-DSCH
SFN Cycle 4096
TrCH1 Data PN9fix
TrCH2 Data 16bitRepeat
TFCI 0
Channelization Code 2
Offset
RV Information 0
UE Identity 0
CRC Error Insertion Correct
Payload Data PN9fix
HARQ Process Cycle 6
TTI Start Offset 0
Process Setting File Non

3-8




3.1 Downlink Setup Screen

Table 3.1.1-5 Parameters specific to each FRC H-Set (H-Set1 and H-Set2)

H-Set1 H-Set2
Parameter
QPSK 16QAM QPSK 16QAM
ON, -12.99 ON, -12.02 ON, -12.99 ON, -12.02
HS-PDSCH1 dB, dB, dB, dB,
HS-DSCH HS-DSCH HS-DSCH HS-DSCH
Number of Physical
Channel Code 5 4 5 4
Modulation QPSK 16QAM QPSK 16QAM
T_ransport quck 41 36 41 36
Size Information
Virtual IR Buffer Size
Number of HARQ 9 c?
Processes E:"
Inter-TTI Distance 3 =
o,
o
Table 3.1.1-6 Parameters specific to each FRC H-Set (H-Set3 through H-Set5) o
o
H-Set3 H-Set4 H-Set5 =
Parameter 5=
QPSK 16QAM QPSK QPSK g’
ON, -12.99 ON, -12.02 ON, -12.99 ON, -12.99 o
HS-PDSCH1 dB, dB, dB, dB, =
HS-DSCH HS-DSCH HS-DSCH HS-DSCH g
Number of Physical 5 4 5 5 Q
Channel Code g'
Modulation QPSK 16QAM QPSK QPSK [
'Pransport quck 41 36 41 41
Size Information
Virtual IR Buffer Size 9600 7200 9600
Number of HARQ 6 9 3
Processes
Inter-TTI Distance 1 2 1
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e W-CDMA
I@m Tranzfer Setting
H-Set{@PSK or T6QAME » | | I | —

Wiy=C DR RMC 122kbpstfor P test)

= BMC 12 2kbpsffor Performance test)
RMC 64kbpsifor Performance test)
; ; ; RMC 144kbpsifor Performance test)
on Link: Doven Link Scrambline gy 384kbpsfor Performance test)

Figure 3.1.1-5 W-CDMA menu

Selects the bit rate setting for Reference Measurement Channels
(RMC) specified in 3GPP TS25.101, TS25.104.

RMC 12.2kbps (for RX test)

RMC 12.2kbps (for Performance test)

RMC 64kbps (for Performance test)

RMC 144kbps (for Performance test)

RMC 384kbps (for Performance test)

Table 3.1.1-7 Physical channel powers for RMC 12.2kbps (for RX test)

Z?;':::: Power ratio
CPICH CPICH_Ec¢/DPCH_Ec =-3.32 dB
P-CCPCH P-CCPCH_Ec¢/DPCH_Ec =-5.32 dB
P-SCH & S-SCH SCH_Ec¢/DPCH_Ec =-5.32 dB
PICH PICH_Ec¢/DPCH_Ec =-8.32 dB
DPCH DPCH_Ec/Ior =-10.32 dB

Table 3.1.1-8 Physical channel powers for channels other than
RMC 12.2kbps (for RX test)

Physical .
Channel Power ratio
CPICH CPICH_Ec/Ior =-10 dB
P-CCPCH P-CCPCH_Ec/Ior =-12 dB
SCH SCH_Ec/Ior=-12 dB
PICH PICH_Ec/Ior =-15 dB
12.2 DPCH_Ec/lor = -16.6 dB
kbps
DPC 6411;]:ps DPCH_Ec/Ior =-12.8 dB
H DPCH_Ec/Ior =-9.8 dB
kbps
384 DPCH_Ec/Tor = —5.5 dB
kbps
OCNS The power where the total of all the channels
including OCNS is 0 dB.
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m Transfer Setting menu
The Transfer Setting menu contains the following item.

Transfer Setting

Transfer Setting Wizard |

Figure 3.1.1-6 Transfer Setting menu

e Transfer & Setting Wizard
Note:
This function is available only when MG3700 or MG3710 is
selected in the Select instrument screen.

Displays the Transfer Setting Wizard screen. Every operation
ranging from connecting the PC and MG3700A or MG3710A and
transferring the waveform pattern to the MG3700A or MG3710A,
to loading the waveform pattern into the MG3700A or MG3710A
ARB memory is performed at this screen.

m Tool buttons
Notes:
o Transfer&Setting Wizard is available only when MG3700 or
MG3710 is selected in the Select instrument screen.
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e Calculation & Load and Calculation & Play are available
only when this software is used on MG3710A.

Recall Parameter File

Save Parameter File
Calculate Waveform Pattern
Calculation & Load
Calculation & Play

Transfer & Setting Wizard

Exit

L SEEANER

Clicking a tool button operates the same as the corresponding
commands in the menu.
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m Total Power display

Total Pomer: -253 dB

Figure 3.1.1-7 Total Power display

The total power of the channels that are set to ON (excluding OCNS)
is displayed in this field. If the total power displayed here is out of
+0.01 dB when OCNS is OFF, the warning message shown in Figure
3.1.1-7 i1s displayed during total power calculation, prompting to
normalize the total power.

Warning

Total channel power iz not narmalized to 0 dB.
It iz necezzary to normalize the total power when OGNS 1= OFF,

i P Gancel I

Figure 3.1.1-8 Warning message

Since the total power value displayed here is calculated from the total
power of all the channels that are set to ON, if a channel that includes
DTX (Discontinuous Transmission) is used, the average power within
the time when all the channels are output becomes 0 dB. When a
channel that includes DTX is used, therefore, the average power value
obtained by measuring the RF output level with a power meter does
not match the setting level of the mainframe.

Normalize Power button

MHormalize Power

Figure 3.1.1-9 Normalize Power button

This button is enabled when OCNS is OFF. When this button is
clicked, the value displayed in Total Power is subtracted from the
power of each channel that is set to ON. As a result, the total power is

normalized to 0 dB while retaining the power ratio between channels.

Status display
The status display on the bottom of the screen displays operation

statuses such as a warning occurred during setting.
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3.1.2 Details of setting parameters on main screen

This section describes the details of the setting items on the Downlink

main screen.

Setting Item

Scrambling Code

Functional Outline

Sets the downlink scrambling code number.

Setting Parameters

Setting Range

Scrambling Code 0to 8191

Details

The scrambling code set here is applied to the scramble of all the channels
including CPICH, P-CCPCH, and PICH. Therefore, the primary scrambling
code number should be set normally for this setting.

The primary scrambling code number is expressed as follows:
Primary scrambling code number = 16*1 G =0 to 511)

Setting Item

Number of Frames

Functional Outline

Sets the number of frames to be generated.

Setting Parameters

Setting Range

Number of 1 to the maximum number of frames for the waveform
Frames memory
Auto Check box selected or cleared.

Details Refer to Appendix B for the maximum number of frames for the waveform
memory
When Auto is selected, it automatically calculates the necessary number of
frames for waveform generation, and generates the waveform pattern
accordingly.

Setting Item CPICH

Functional Outline

Performs settings related to CPICH.

Setting Parameters

Setting Range

ON/OFF ON or OFF

Power —40.00 to 0.00 [dB], setting resolution: 0.01 dB
Details The channelization code of the CPICH is fixed to 0.
Setting Item P-CCPCH

Functional Outline

Performs settings related to P-CCPCH.

Setting Parameters

Setting Range

ON/OFF ON or OFF

Power —40.00 to 0.00 [dB], setting resolution: 0.01 dB

P-SCH & S-SCH Power —40.00 to 0.00 [dBI, setting resolution: 0.01 dB

Details

The channelization code of the P-CCPCH is fixed to 1.
BCH is mapped for P-CCPCH.

3-13
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Setting Item

PICH

Functional Outline

Performs settings related to PICH.

Setting Parameters

Setting Range

ON/OFF

ON or OFF

Power

—40.00 to 0.00 [dB], setting resolution: 0.01 dB

Channelization Code

0 to 255

3-14




3.1 Downlink Setup Screen

Setting ltem DPCH

Functional Outline Performs settings related to Downlink DPCH.

Setting Parameters Setting Range
ON/OFF ON or OFF
Power —40.00 to 0.00 [dB], setting resolution: 0.01 dB
Channelization Code OtoSF-1

SF (spreading factor) varies depending on the
setting of Data as follows:

RMC 12.2 kbps = 128
RMC 64 kbps = 32

RMC 144 kbps =16

RMC 384 kbps =8
AMR1/AMR2/AMR3 = 128
ISDN = 32

384 kbps Packet = 8

User Edit TrCH = Spreading Factor set in the
Channel Edit screen

Data RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/
RMC 384 kbps/AMR1/AMR2/AMRS3/ISDN/
384 kbps Packet/User Edit TrCH

Details Each channel coding parameter of the DCH is set according to the standard
format selected by Data.

RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/RMC 384 kbps

Refer to 3GPP TS25.101 Annex A.3 DL reference measurement channel for
details of these channels. See the next and subsequent pages for details of
each parameter.

AMR1/AMR2/AMR3/ISDN

Refer to 3GPP TR25.944 4.1.1.3 Example for DCH for details of these
channels. See the sections below for details of DTCH, DCCH, and
Multiplexing.

DTCH

AMRI: 4.1.1.3.1.2 Example for 12.2 kbps data (TFS =#1)

AMRZ2: 4.1.1.3.1.2 Example for 12.2 kbps data (TFS = #2)

AMRS3: 4.1.1.3.1.2 Example for 12.2 kbps data (TFS = #3)

ISDN: 4.1.1.3.1.6 Example for 64 kbps data
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DCCH

AMRI/AMRZ2/AMRS/ISDN: 4.1.1.3.1.1 Example for 3.4 kbps data
Multiplexing

AMRI/AMRZ/AMRS3- 4.1.1.8.2.2 Example for multiplexing of 12.2 kbps

data and 3.4 kbps data
ISDN: 4.1.1.3.2.5 Example for multiplexing of 64 kbps data and 3.4 kbps data

User Edit TrCH

When User Edit TrCH is selected, the settings of parameters for TrCH can be
changed on the Channel Edit screen that is opened by clicking the Channel
Edit button. Select User Edit TrCH when setting a channel other than the
standard transport channels described above.
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+ DL_RMC_12_2 kbps channel coding parameters

Table 3.1.2-1 DL reference measurement channel 12.2 kbps
physical channel parameters

Parameter Unit Level
Information bit rate kbps 12.2
DPCH ksps 30
Slot Format #i - 11
TFCI - On
Power offsets PO1, PO2 and PO3 dB 0
Puncturing % 14.7

Table 3.1.2-2 DL reference measurement channel 12.2 kbps
transport channel parameters

Parameter DTCH DCCH
Transport Channel Number 1 2
Transport Block Size 244 100
Transport Block Set Size 244 100
Transmission Time Interval 20 ms 40 ms
Type of Error Protection Convolution Coding Convolution Coding
Coding Rate 1/3 1/3
Rate Matching attribute 256 256
Size of CRC 16 12

3-16
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Downlink Setup Screen

DTCH

DCCH

Information data 244 Information data 100
CRC attachment 244 — CRC16 CRC attachment 100 CR.C12
Termination 12 Tailg
Tail bit attachment 260 Tail bit attachment 112 /|
Conv. coding R=1/3 804 ] Conv. coding R=1/3 360
Rate mtching 686 Rate maching 308
1st interleaving 686 1st intedeaving 308
Radio Frame #1343 | 343 | #Ma4s | #aas | (MTI|RTIBTI[HTT
segmentation
343 | 77 343 | 77 343 | 7 343 | 77
2nd interleaving
_ 420 _ _ 420 . _ 420 ' _ 420 _
slot segmentation @ IE @ @ IE E IE

30ksps DPCH
(including TFCI bits)

28 28

28

28 28

28 28 28

28 28 28

28

(O[1] «er [@)O]T] = [A4{OJT] «eer [14JOJT] «o-- [

Radio frame FN=4N

Radio frame FN=4N+1

Radio frame FN=4N+2

Radio frame FN=4N+3

Figure 3.1.2-1 Channel coding for DL reference measurement channel 12.2 kbps
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+ DL_RMC_64 kbps channel coding parameters

Table 3.1.2-3 DL reference measurement channel 64 kbps

physical channel parameters

Parameter Unit Level
Information bit rate kbps 64
DPCH ksps 120
Slot Format #i - 13
TFCI - On
Power offsets PO1, PO2 and PO3 dB 0
Repetition % 2.9

Table 3.1.2-4 DL reference measurement channel 64 kbps

transport channel parameters

Parameter DTCH DCCH
Transport Channel Number 1 2
Transport Block Size 1280 100
Transport Block Set Size 1280 100
Transmission Time Interval 20 ms 40 ms
Type of Error Protection Turbo Coding Convolution Coding
Coding Rate 1/3 1/3
Rate Matching attribute 256 256
Size of CRC 16 12
Position of TrCH in radio frame fixed fixed
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DTCH DCCH
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Figure 3.1.2-2 Channel coding for DL reference measurement channel 64 kbps
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+ DL_RMC_144 kbps channel coding parameters

Table 3.1.2-5 DL reference measurement channel 144 kbps

physical channel parameters

Parameter Unit Level
Information bit rate kbps 144
DPCH ksps 240
Slot Format #i - 14
TFCI - On
Power offsets PO1, PO2 and PO3 dB 0
Puncturing % 2.7

Table 3.1.2-6 DL reference measurement channel 144 kbps

transport channel parameters

Parameter DTCH DCCH
Transport Channel Number 1 2
Transport Block Size 2280 100
Transport Block Set Size 2280 100
Transmission Time Interval 20 ms 40 ms
Type of Error Protection Turbo Coding Convolution Coding
Coding Rate 1/3 1/3
Rate Matching attribute 256 256
Size of CRC 16 12
Position of TrCH in radio frame fixed fixed
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Information data 2880 Information data 100
CRCTZ
CRC attachment 2880 — CRC16 CRC attachment 100
Taild
Tail bit attachment 2896 | Tail bit attachment 112 /I
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Figure 3.1.2-3 Channel coding for DL reference measurement channel 144 kbps
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+ DL_RMC_384 kbps channel coding parameters

Table 3.1.2-7 DL reference measurement channel 384 kbps

physical channel parameters

Parameter Unit Level
Information bit rate kbps 384
DPCH ksps 480
Slot Format #i - 15
TFCI - On
Power offsets PO1, PO2 and PO3 dB 0
Puncturing % 22

Table 3.1.2-8 DL reference measurement channel 384 kbps

transport channel parameters

Parameter DTCH DCCH
Transport Channel Number 1 2
Transport Block Size 3840 100
Transport Block Set Size 3840 100
Transmission Time Interval 10 ms 40 ms
Type of Error Protection Turbo Coding Convolution Coding
Coding Rate 1/3 1/3
Rate Matching attribute 256 256
Size of CRC 16 12
Position of TrCH in radio frame fixed fixed
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DTCH DCCH
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Figure 3.1.2-4 Channel coding for DL reference measurement channel 384 kbps
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Setting Item OCNS
Functional Outline Sets OCNS ON/OFF.
Setting Parameters Setting Range
ON/OFF ON or OFF
Type 16 Codes/6 Codes(ch=122-127)/6 Codes(ch=2-7)

Details

When OCNS is set to ON, the power of OCNS (Orthogonal Channel Noise
Simulator) is adjusted so that the total power of all the channels that are set
to ON becomes 0 dB.

Since the OCNS power is calculated from the total power of all the channels
that are set to ON, if a channel that includes DTX (Discontinuous
Transmission) is used, the average power within the time when all the
channels are output becomes 0 dB. When a channel that includes DTX is
used, therefore, the average power value obtained by measuring the RF
output level with a power meter does not match the setting level of the
MS2690A/MS2691A/MS2692A or MS2830A.

When the total power of all the channels that are set to ON (excluding
OCNS) exceeds 0 dB while OCNS is set to ON, an error occurs and data
generation is cancelled. The total power of all the channels that are set to ON
(excluding OCNS) is displayed in Total Power on the screen.

To clear this error, set OCNS to OFF or attenuate the power of each channel.
For example, when P-CCPCH, CPICH, and DPCH are set as follows, the
total power of the channels except OCNS exceeds 0 dB. OCNS cannot be set
to ON in this event, and it is regarded as an error.

An error may occur when the actual total power exceeds 0 dB at the
thousandth or later places that are not displayed, even if 0.00 dB is displayed
in Total Power on the screen.

P-CCPCH = -3.00dB
CPICH = -3.00 dB Total > 0.0 dB
DPCH =-3.00 dB
OCNS =?

When OCNS is set to OFF, click the Normalize Power button to adjust the
power of each channel so that the total power of all the channels becomes 0
dB while retaining the power ratio between channels.

P-CCPCH =-3.00 dB Normalize P-CCPCH =-4.80 dB

CPICH=-3.00dB | C__—__——_ > | CPICH=-4.80dB

DPCH =-3.00 dB DPCH =-4.80 dB
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3.1 Downlink Setup Screen

Details (Cont'd)

OCNS consists of 6-channel (for HSDPA) or 16-channel (for Performance

requirement) DPCH. The tables below show the parameters. Refer to 3GPP
TS25.101 (Release 6) C5.2 “OCNS Definition” Tables C.6 and C.12 for details.

OCNS (6 channels, ch2 to 7)

Channelization Relative Level
Code at SF = 128 Setting (dB)
2 0
3 -2
4 -2
5 -4
6 -1
7 -3

OCNS (6 channels, ch122 to 127, TS25.101 V5.12.0 or later)

Channelization Relative Level
Code at SF = 128 Setting (dB)
122 0
123 -2
124 -2
125 -4
126 -1
127 -3
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Chapter 3 Detailed Description of Functions

Details (Cont'd)
OCNS (16 channels)
Channelization Relative Level
Code at SF =128 Setting (dB)

2 -1

11 -3

17 -3

23 -5

31 -2

38 -4

47 -8

55 =7

62 -4

69 -6

78 -5

85 -9

94 -10

125 -8

113 -6

119 0
[Displayed contents]
An OCNS item Power displays the power of OCNS only. The total of this
value and the value displayed in Total Power is always 0 dB.
The Channelization Code and SF (spreading factor) used by OCNS are also
displayed.
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3.1 Downlink Setup Screen

Setting Item HS-SCCH1, HS-SCCH2, HS-SCCH3, HS-SCCH4
Functional Outline Sets the physical parameters of HS-SCCH.
Setting Parameters Setting Range
ON/OFF ON or OFF
Power —40.00 to 0.00 [dB], setting resolution: 0.01 dB
Channelization Code 0 to 127
Data PN9/PN9fix/PN15fix/16bitRepeat/Coded
Details ON/OFF

Toggles the HSDPA channel ON/OFF. This setting is commonly applied to
HS-PDSCHI1 to 4 that correspond to HS-SCCHI1 to 4, respectively. When
HS-SCCH1 is set to OFF, for example, HS-PDSCHA1 is also set to OFF.

3

Data o
This setting indicates the type of data sequence to be inserted to the g"
subframes of HS-SCCH 1 to 4. PN9fix and PN15fix are PN9/PN15 data reset =
by each subframe. PN data is not continuous between subframes. 8_.
Select Coded when transmitting control data related to HSDPA on the w)
HS-SCCH. 2
5.
Setting Item HS-PDSCH1, HS-PDSCH2, HS-PDSCHS3, HS-PDSCH4 gﬁ
Functional Outline Sets the physical parameters of HS-PDSCH. =}
Setting Parameters Setting Range =
ON/OFF ON or OFF =
Power —40.00 to 0.00 [dB], setting resolution: 0.01 dB 5'_
Channelization Code Displays Channelization Code. o
Data PN9/PN9fix/PN15fix/16bitRepeat/HS-DSCH B
Details ON/OFF

Toggles the HSDPA channel ON/OFF. This setting is commonly applied to
HS-SCCHI1 to 4 that correspond to HS-PDSCHI1 to 4, respectively. When
HS-PDSCH1 is set to OFF, for example, HS-SCCHA1 is also set to OFF.

Data

This setting indicates the type of data sequence to be inserted to the
subframes of HS-PDSCH1 to 4. PN9fix and PN15fix are PN9/PN15 data reset
by each subframe. PN data is not continuous between subframes.

Select HS-DSCH when mapping the data sequence that was channel-coded
according to 3GPP TS25.212 (Release 6) to HS-PDSCH.
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3.1.3 Details of setting parameters on Channel Edit screen
When the Channel Edit button is clicked, the Channel Edit screen shown

below is displayed. This section describes the details of the setting items
on this screen.

Channel Edit x|
P-GGPGH Edit
SFM Cycle
DPCH Edit
PhyGH

EER. I’ %
Slot Format I#ﬂ 'I

DPCH Data  [T.0r =
TFCI |D _,::'

Spreading Factar |128 VI Timing Offset ID _|; TR Edit
TrCH
Easy, Setup | TrGH Number m DTx m
| | '
TrGH1 TrCH2 TrisHE TriHd
Data | |PMOfix =l | [ibitRepeat =] | [ = | F =
TTI |20ms LI |4Ums LI I‘ LI I_ LI
Max. TrBk Size 244 hit 100 hbit I' bit I_ it
TrBk Siee | |21 Bit iy bit F bit F bit
Max TrBk Set Mo TrEk * |1 TeEk * |1 TrEk * I— TeBk * |-

TrBk Set No. TrBk * |1 TrEk + [1

cre | [iebit =] Jizpit =] |- | E |
Goder | [CC1/ =] [coia ] E =l E |
RM attribute [56 | E [ [
BER | [ | F F
Ber | F F— F F
Cancel |

Figure 3.1.3-1 Channel Edit screen

B OK and Cancel buttons
The OK and Cancel buttons are provided to close the Channel Edit
screen after performing setting.

e When the OK button is clicked:
The Channel Edit screen is closed, applying the settings.

e When the Cancel button is clicked:

The Channel Edit screen is closed, ignoring the settings.
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3.1 Downlink Setup Screen

Setting ltem P-CCPCH Edit
Functional Outline Performs settings for P-CCPCH.
Setting Parameters Setting Range
SFN Cycle ‘ Short or 4096
Details This is the cycle of SFN (System Frame Number) that is transmitted by BCH

mapped to P-CCPCH.

When set to Short, the cycle of SFN becomes a common multiple of the
maximum TTI cycle. This will shorten the calculation time and lessen the
data volume and number of frames to be generated. If the normal cycle of
4096 is required, set to 4096.
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Setting Item

DPCH Edit (PhyCH)

Functional Outline

Performs settings for DL-DPCH physical channels.

Setting Parameters

Setting Range

DPCH Data

PN9/PN9fix/PN15fix/16 bitRepeat/TrCH

TFCI

0 to 1023

Spreading Factor

4, 8, 16, 32, 64, 128, 256, 512

BER

0.0 to 100.0%, setting resolution: 0.1%

Slot Format

#0 to #16

Timing Offset 0 to 149
TPC Edit 0000 0000 0000 0000 0000 0000 0000 0000 0000
0000 0000 0000 0000 0000 0000 to
111111111111 11117 1111 1111 1111 1111 1111
111111111111 111111111 1111
Details DPCH Data

Selects the data to be inserted to DPCH of the physical channel.
PN9fix/PN15fix is PN9/PN15 data reset by each frame. PN data is not
continuous between frames. When performing operations such as BER (Bit
Error Rate) measurement for a reception sensitive test, select PN9 with
which PN data is continuous between frames. When [PN9fix, PN15fix, or PN9
is selected, a physical frame structure is not configured since PN data is
mapped to all areas of DPDCH and DPCCH in this event.

PN9 can be set only when all four HSDPA channels are set to OFF.

When TrCH is selected, a physical frame structure is configured for DPDCH
and DPCCH, and the data for which DCH frame coding is executed is

inserted to DPDCH.
Slot Format, TPC Edit

These can be set only when DPCH Data is set to TrCH.

BER

Sets the error rate to be inserted to the transmission data.

This setting is valid when DPCH Data is set to PN9.

When DPCH Data is set to PN9, an error is randomly inserted to the PN9
data that is inserted directly to a physical frame.

Timing Offset

Sets an offset for the DPCH frame timing for P-CCPCH with a value of 256

chip multiplied by n.
TPC Edit

Sets the data to be inserted to the TPC bit in a 4-frame cycle. Each bit
indicates the symbol (0/1) of the TPC bit to be assigned to each slot. Data is
assigned to each slot sequentially from the left.
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3.1 Downlink Setup Screen

Setting ltem DPCH Edit (TrCh Edit)
Functional Outline Performs settings for TrCH.
Setting Parameters Setting Range
TrCH Number 1to8
DTX Fix/Flex
Data PN9/PNO9fix/PN15fix/16 bit Repeat/User File
TTI 10, 20, 40, 80 ms
Max. TrBk Size 0 to 5000
TrBk Size 0 to 5000
Max. TrBk Set No. 0 to 64
TrBk Set No. 0 to 64
CRC 0, 8, 12, 16, 24 bits
Coder CC1/2, CC1/3, TC
RM attribute 1 to 256
BER 0.0 to 100.0%, setting resolution: 0.1%
BLER 0 to 100%, setting resolution: 1%
Details TrCH Number

Sets the number of TrCH (transport channels). The number of TrCh that can
be edited varies depending on this setting.

Data

Selects the data to be inserted to Information Data of the transport channel.
PN9fix/PN15fix is PN9/PN15 data reset at the last data of a signal. The last
data of a signal and the first data of the next signal are not continuous.

PN9 can be set only when all four HSDPA channels are set to OFF.

Max. TrBk Size, Max. TrBk Set No.
Sets the maximum TrBk Size and the number of TrBk Sets in TFCS.

Coder
Selects the channel coding type. CC1/2 and CC1/3 indicate a convolutional
code at coding rates of 1/2 and 1/3 respectively. TC indicates a turbo code.

BER

This setting is valid when Data is set to PN9. The bits in the information
data to be inserted to the transport channel are randomly inverted according
to the specified error rate.

BLER

This setting is valid when Data is set to PN9. Half of the bits in the CRC to
be added to each transport block are inverted randomly according to the
specified error rate.
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3.1.4 Details of setting parameters on HSDPA Edit screen
When the Edit button is clicked, the HSDPA Edit (Ch1 to Ch4) screen

shown below is displayed. This section describes the details of the setting
items on this screen.

HSDPA Edit (Ch1) |
GChannelization Code Offset UE Identity IU =
MNumber of Phyzical Channel Code GRC Error Inzertion IOorrect VI
Modulation  |QPSE MNumber of HARG Processes |2 31

Transport Block Size Information

Wirtual IR Buffer Size IQISDU 52
Pavload Data IPNinx VI

103

RV information

Tranzmitting Pattern Edit

HARG! Process Cyole Iﬁ 32 Inter-TTI Distance |3 E
TTI Start Offzet ID 31
" Procese Setting File | _I

oK | Cancel |

Figure 3.1.4-1 HSDPA Edit screen

B OK and Cancel buttons
The OK and Cancel buttons are provided to close the HSDPA Edit

screen after performing setting.

e When the OK button is clicked:
The HSDPA Edit screen is closed, applying the settings.

e When the Cancel button is clicked:
The HSDPA Edit screen is closed, ignoring the settings.
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Setting Item

HSDPA transport channel parameter

Functional Outline

Sets the parameters for HS-SCCH and HS-PDSCH.

Setting Parameters

Setting Range

Channelization Code 1 to (16 — Number of Physical Channel Code)
Offset

Number of Physical 1 to (16 — Channelization Code Offset)
Channel Code

Modulation QPSK or 16QAM

Transport Block Size 0to 63

Information

RV Information Oto7

UE Identity 0 to 65535

CRC Error Insertion Correct or Fail

Number of HARQ Oto8

Processes

Virtual IR Buffer Size 800 to 304000

Payload Data PN9/PN9fix/PN15fix/16 bitRepeat

Details

[Channelization Code Offset, Number of Physical Channel Code, Modulation,
Transport Block Size Information, RV Information, UE Identity]

When Coded is set for Data of HS-SCCH or HS-DSCH is set for Data of
HS-PDSCH on the main screen, the data for which channel coding is
performed according to these settings is assigned to HS-SCCH or
HS-PDSCH.

[Channelization Code Offset, Number of Physical Channel Code]

These settings are transmitted on HS-SCCH as “channelization code
set-bits.”

Code Offset indicates the start number of each channelization code of
HS-PDSCH.

Number of Physical Channel Code indicates the number of HS-PDSCH
codes.

These settings have an effect on their setting range each other, as described
above.

[CRC Error Insertion]
Because the CRC bits of all the transport blocks are inverted when Fail is
selected, an error occurs for a CRC check at reception.

[Number of HARQ Processes]

Indicates the number of HARQ processes.

Refer to the description of the “Transmitting Pattern Edit” setting item for
details.

[Payload Data]

Selects the data to be used for HS-DSCH.

PNOfix/PN15fix is PN9/PN15 data reset by each HARQ process. PN data is
not continuous between HARQ processes. When any HSDPA channel is set to
ON, PN9 cannot be selected for DTCH Information Data. If any HSDPA
channel is changed to ON while PN9 is set for DTCH Information Data, DTCH
Information Data is changed to PN9fix.
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Chapter 3 Detailed Description of Functions

Setting Item

Transmitting Pattern Edit

Functional Outline

Sets the HARQ process output pattern.

Setting Parameters

Setting Range

HARQ Process Cycle 1 to 16 (1 to 6 when PN9 is set for Payload Data)
Inter-TTI Distance 1to8

TTI Start Offset Oto7

Process Setting File Use or Not use

Details

[HARQ Process Cycle]
Sets the repetition cycle of the HARQ Process set by Number of HARQ
Processes in the subframe (2 ms) units.

[Inter-TTI Distance]

Sets the interval between HARQ Processes by in the subframe (2 ms) units.
Note, however, that the TTI between the HARQ process cycles does not
match this setting value if Inter-TTI Distance x Number of HARQ Processes
does not equal to the value of HARQ Process Cycle.

[TTI Start Offset]

The HARQ process start timing is delayed by this setting in subframe units.
When two or more HSDPA channels are set to ON and their HARQ Process
Cycles are same, the output timing of each HSDPA channel can be delayed
by using this setting.

[Process Setting File]

When this check box is selected, the “Open file” screen is displayed to select a
process setting file to be read for setting the transmission pattern of
HS-SCCH and/or HS-PDSCH. The HARQ Process is set based on the settings
in the process setting file selected in this screen.

When the process setting file is selected, the settings of HARQ Process
Cycle, Inter-TTI Distance, and TTI Start Offset are invalid.

A process setting file should a text file with the extension “.txt,” and should
be created in the format as shown below:

#MX269901A HSDPA IQproducer Process Setting File
Process Cycle = 6 frame

01020

30405

06070

80102
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3.1 Downlink Setup Screen

Details (Cont'd) There are the following restrictions on process setting files:

(1) Process cycle: 1 to 512 frames

(20 HARQ process number: 0, 1, 2, ..., 8 (0 indicates DTX.)

(3) Although each line is fed by 5 characters (5 subframes = 1 frame) in the
example above, commas (,), periods (.), spaces, and line feed characters
are ignored.

(4) If Payload Data = PN9 and Process Cycle > 7, the data length is greater
than the waveform memory capacity of the mainframe, resulting in an
error. Set Payload Data to other than PN9.

(5) When the same process number appears, it is regarded as a new HARQ
process and the NDI (New Data Indicator) bit in HS-SCCH is
automatically changed from 0 to 1 or from 1 to 0. The NDI bit is set to 0
at the beginning of the waveform pattern in all HARQ process cycles.

3

One subframe

<+—>
Process Process Process | Process
1 2 3 1
DTX DTX DTX DTX DTX
NDI =0 NDI=0 NDI=0 | NDI = 1

Inter-TTI Distance = 3

. 4

<

HARQ Process Cycle =7

The next Process Cycle starts
according to the setting of
HARQ Process Cycle.

suorjoun,f Jo uorpdrIosa(] parreroq

Figure 3.1.4-2 HARQ Process Cycle
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3.1.5 Calculation screen

Clicking Calculation & Load, Calculation & Play, or the OK button on
the Export File name Input screen box will start the waveform

generation.

The Calculation screen is displayed while a waveform pattern is being
generated. On this screen, the progress bar is displayed indicating the
generation process of the waveform pattern and the progress of the
waveform pattern generation. The generation of the waveform pattern
can be stopped by clicking the Cancel button. When cancelled, it returns
to the main screen.

Galculation

Creating Parameter File... &
Prog ress report AN [ Generating Packets ] _I
[ Adjusting Level ]
111 Stream

Progress bar
_\id

Cancel button

Figure 3.1.5-1 Calculation Screen (In Progress)

After waveform pattern generation is finished, the message “Calculation
Completed.” is displayed in the progress window and the Cancel button
changes to the OK button.

When the generation is complete, you can return to the setting screen by
clicking the OK button. After waveform generation, two files with .wvi

and .wvd extension are output.

Cresating Parameter File d
[ Generating Packets ]
[ Adjusting Level ]

111 Stream
[ Generating Mew File ]

111 Stream
Calculstion Completed

=

Figure 3.1.5-2 Calculation Screen (Completed)

Note:
When using this software on MG3710A, and selecting Calculation
& Load or Calculation & Play, the waveform generation ends
without displaying the above screen.
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3.1 Downlink Setup Screen

3.1.6 Calculation & Load

Note:
This function is available only when this software is used on
MG3710A.

When Calculation & Load is selected, the Load Setting screen will
display after waveform generation.

Load Setting 5 x|
~Wiave Pattemn
Package Hproducer
I:> SG1 / Memaryf
Pattern Name ‘WaveformPattern /

‘ OK / Cancel |

/

Button for selecting load destination /

Figure 3.1.6-1 Load Setting Screen

The Select Memory screen will display after clicking the load destination

in the Load Setting screen.

(X

Select Memory

81
Memory f Memary B

BG2

=)
@
—+
V]
|':
(0]
[oH
=)
(0]
n
<]
x]
(=0
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t+
[ =
=}
B
=]
Fh
=
=]
B
Q
—+
e
=]
=]
n

e mory & ‘ Memary B ‘

Gancel

Figure 3.1.6-2 Select Memory Screen

After selecting the load destination of generated waveform in the Select
Memory screen and clicking the OK button, the Load Setting screen will
be shown again. Click the OK button in the Load Setting screen, and

then the loading of waveform starts.

Notes:
e To exit this screen without loading the waveform pattern, click
the Cancel button in the Load Setting screen.
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e If the configuration of generated waveform pattern used two
memories, the Select SG screen displays just like Calculation &
Play.

3.1.7 Calculation & Play
Note:

This function is available only when this software is used on
MG3710A.

When Calculation & Play is selected, after waveform creation is

completed, the created waveform is loaded into memory, selected and

output.

When the 2nd Vector Signal Generator (option) is installed, the Select SG
screen is displayed before the start of waveform generation. This screen

1s used to select the signal generator for outputting the created waveform

pattern.

L se SG2 ‘

Figure 3.1.7-1 Select SG Screen

3.1.8 Saving/reading parameters

This numeric values and settings for each item can be saved in a

B Saving parameter file

parameter file by using this software.

When running on PC, MS2690A/MS2691A/MS2692A, or MS2830A

1.

Select Save Parameter File from the File menu or click the £

tool button to display the parameter file saving screen shown below.

Enter a file name in the File name text box and click the Save
button to save the parameter file.

When the save destination is not changed in the Save in box, the
parameter file is saved in the following directory with the entered
file name:

X\IQproducer\HSDPAN\ Entered file name.prm

(“X:\IQproducer” indicates the folder where the IQproducer™ is
installed.)
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savens 21x]
Saveju | I HSDPA R I s ==

Daka Iﬂ H5DApinit_MS262:8. prm

|®]HSDADowririt.prm
U HSDADowninit_MS269x4. prm
|| HsDaUpinit.prm

File name: | Save I
Save a3 ype: ISetting Files [*.prr) j Cancel |
e

Figure 3.1.8-1 Parameter file saving screen

When running on MG3710A )
. . . Gy (¢”]
(1) Select Recall Parameter File from the File menu or click the & S
. . . =t o
tool button to display the parameter file reading screen. Y
= o
Drives  Windows? (G) - File Name I [¢]
17}
[¢)]
x]
[=n
Directories File List '.E'_
& IQproducer 2l [HSDADowninit prm = -
1xEVDO_FWD HSDADowninit MG3710A prm )
1xEVDO RVS HSDADowninit MS269xA prm b
AWGN - HSDADowninit MS2830A prm o
HSDAUpinit prm =Y
GoDF HS DAUpinit_ MG3710A prm
Clipping HS DAUpinit MS269xA.prm =l =
Convert ;:.‘
DVB-TH s B
Fading G*Anritsu¥[Qproducer¥HSDPA% 9'.
FFT .
8
IQproducer ®n
LTE
I TF THhN ~| Default Root OK Cancel

Figure 3.1.8-2 Parameter file saving screen (MG3710A)

(2) Select the directory where the files to be loaded is stored in the
Directories field. Click the desired file from the File List, and click
OK. To initialize the setting in the Directories field, click the Default
Root button.
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B Reading parameter file
When running on PC, MS2690A/MS2691A/MS2692A, or MS2830A
1. Select Recall Parameter File from the File menu or click the &

tool button to display the parameter file reading screen shown.

2. Select a parameter file to be read from the file list, and then click
the Open button to read the selected parameter file.

open 21x]
Look jn: | 5 HSD P& R I s ==

Daka Iﬂ H5DApinit_MS262:8. prm

|®]HSDADowririt.prm
B HSDADowninit_MS269x4. prm
|| HsDaUpinit.prm

File name: | Open I
Files of type: ISetting Files [*.pron) j Cancel |
VA

Figure 3.1.8-3 Parameter file reading screen

When running on MG3710A
(1) When User File is selected for Data Type setting in the Channel
Setting screen, the user file reading screen is displayed.

Drives  windos? € -

Directories File List

IQproducer =" [HSDADowninit.prm 2

1xEVDO FWD HSDADowninit MG3710A prm
N HSDADowninit MS269xA prm
L);VE(\;NDO’RVS J HSDADOWninitiMS?SSOA,Erm
HSDAUpinit prm

cebr HSDALpinit MG3710A prm
GClipping HS DAUpinit MS269xA prm =l
‘Convert
-DVB-TH
Fading
FFT
IGproducer
LTE
1 TE TNN ~| Default Root OK Gancel

Figure 3.1.8-4 Parameter file reading screen (MG3710A)

(2) Select the directory where the user files to be loaded is stored in the
Directories field. Click the desired file from the File List, and click
OK. To initialize the setting in the Directories field, click the Default
Root button.
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3.1 Downlink Setup Screen

3.1.9 Generating waveform pattern file

A waveform pattern file to be used in the mainframe can be generated
based on the setting values. In the screen shown in Figure 3.1.9-2, the
waveform pattern name and comments can be entered and whether to
enable or disable the RRC filter can be set.

The number of frames to be generated varies depending on the setting
conditions for each channel, and the time required for generating a

waveform pattern also varies accordingly.

<Procedure>
1. Select Calculate Waveform Pattern from the Edit menu or click the

Wl | tool button.

At this time, the Warning message shown below appears when OCNS
> is set to OFF and the value of Total Power is out of +0.01 dB.

Wlarning

Total channel power iz not normalized to O dBE.
It iz neceszary to normalize the total power when OGRS iz OFF.

Cancel |

Figure 3.1.9-1 Warning message
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Click the OK button to normalize the Total Power and proceed with the

next step.

__________________________________________________________________________________________________________________
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2. The file name input screen is displayed.

Qutput File Hame

File name display area—_ [estove
test_fwwvi

test_fnd

test_Blwwi

Output destination folder lisid B
selection button

Export Path

|C:¥ Program Files¥Anritsu Corporation¥lCproducer¥HSDP A¥Dal

Packaee

|

Package name input box ___—HSDFA Downlink
Cutput File Mame

Output file name input box ——ft=st

Camment

Comment input box —_—1

|
RRC Filter Off checkbox_——_—"T" RRG Filter Off

Cancel _|

Figure 3.1.9-2 File name input screen

Enter a package name in the package name input box, up to 31

characters.

Enter a file name in the file name input box, up to 18 characters.
1-byte alphanumeric characters and the following symbols can be

used for a file name:

%&O)+="1_-~@l]

When a file name is entered, the file to be generated is displayed in

the file name display area in the following format:

File name format:

test_A.wvi
I—)Extensioni wvi... Information file (text format)
wvd... Data file (binary form at)
Memory to read: A---Memory A
B---Memory B
t——>FEntered file name

Enter a comment for the waveform pattern in a comment input box.
Three comment input boxes are provided, and a comment can be

entered in each line within 38 characters.
1-byte alphanumeric characters and symbols can be used for

comments.
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3.1 Downlink Setup Screen

The contents of each comment are displayed on the screen when the
corresponding waveform pattern is selected by the Vector Signal
Generator. Leave the comment boxes blank if not necessary.

When the RRC Filter Off check box is selected, symbol data that
does not pass through the RRC filter is generated as a waveform
pattern. This check box needs not be selected under normal

conditions.

Click OK on the Export File screen. The Calculation screen shown in

3

Figure 3.1.5-1 is displayed and waveform pattern generation starts

(the output destination folder, package name, and file name must be

set to start waveform pattern generation).

When started with MS269x or MS2830A and when MS269x or
MS2830 is selected in the in the Select instrument screen, waveform

pattern files generated by this application are saved in the following

directory:
Installed OS Export destination folder
Windows Embedded | C:\Anitsu\Signal Analyzer\
Standard 7 System\Waveform
Other than above C:\Program Files\Anritsu Corporation\
Signal Analyzer\System\Waveform

suorjoun,f Jo uorpdrIosa(] parreroq

When used with MG3710A, the files are saved in the following
directory:

C\Anritsu\MG3710A\User Data\Waveform

In other cases, clicking the output destination selection button
displays the Browse for Folder screen shown in Figure 3.1.9-3. The

output destination folder can be selected from this screen.
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Select Folder

[#-7) 1xEVDO_FWD -
-7 1xENDO_RYS
{3 BWGH
{7 CCDF J
7)) Convert
~{5) D¥B-T_H
o Ll
=5 HSDPa

----- i) DPCH_Param

5 mesa il
4 | »

(] 4 I Cancel |

Figure 3.1.9-3 Browse for Folder screen

If no destination folder is selected, the file is generated in the
following folder.

XA\IQproducer\HSDPA\Data

(Where “X:\IQproducer” is the folder you installed IQproducer™).

The HSDPA/HSUPA Uplink IQproducer waveform pattern file
generation and the HSDPA/HSUPA Downlink I1Qproducer
waveform pattern file generation must be operated exclusively.

An error dialog box will be displayed if the HSDPA/HSUPA
Uplink IQproducer waveform pattern file generation is started
while the HSDPA/HSUPA Downlink IQproducer waveform
pattern file generation is operating, and vice versa. To start the :
HSDPA/HSUPA Uplink/Downlink IQproducer waveform pattern
file generation while the other is operating, cancel the other file :

generation or wait until the other file generation is completed.

..................................................................................................................
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3.1 Downlink Setup Screen

3.1.10 Auxiliary signal output
When a waveform pattern generated by this software is selected by the
mainframe, a marker signal synchronized with the RF signal is output
from the AUX input/output connector of the rear panel as an auxiliary
signal. TTI Pulse (Connector 1) is output.

o TTI Pulse
TTI cycle pulse synchronized with the symbol at the beginning of the
frame is output from Connector 1. The signal polarity can be changed

by changing the polarity of Marker 1.
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Chapter 3 Detailed Description of Functions

3.2 Uplink Setup Screen

3.2.1 Main screen

On common platform screen, click the System (Cellular) tab, and then
click HSDPA/HSUPA Uplink to display the main screen.

E'ls‘ﬁ HSDPA Uplink IQproducer. for MG3700
Menu __+File Edit Transfer Settine

o | By

ul | 0o | 2 | i | A

Tool buttons —{

Simulation Link: Up Link Scrambling Gode |1 - Normalize Power Mumber of Frames 00— ¥ Auto
Normalize Power
button UL-DRCCH  |ON ~|  Power [524 4B GhGude® OSF = 256 Mmax-dpdch [T = |
Edit
UL-DPDCGH  [OM =] Power [254 dE  Ch Codel TRSF =4 Data |RMO122kbps v |
HS-DPCCGH OM bt Ch Coded@) 64.5F = 266 TimingOffset n “Ti 256 chip
ACK Power |-13.20 dB
ACK Pattern | AGK anly =
NAGK Power |-1320 dB
GOT Power |-13.20 dB GOl value |2 El
[ Pattern Settine File | J

E-DPCGCH OM hd Power |-13.20 dE Ch Codell = 1. 5F = 286 Data  |Coded

Edit
E-DFDCHiE! oM - Power |-13.20 dB Data  |E-DCGH

Ch Code@) = 128(5F266)
E-DPDGHISF2} Power,” E-DPDGHISF4) Power  [300 dE Oihen 2512 and 2sf4 selected)

Figure 3.2.1-1 Uplink main screen
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3.2 Uplink Setup Screen

m File menu
The File menu contains the following items.

Select Option With Option21 (Memary 512M samples)
Eecall Parameter File & Without Option21 (Memary 512M samples!
Save Parameter File e =1
Exit |

Figure 3.2.1-2 File menu

e Select Option
Notes:

e This function is available only when MG83700, MG3710 or
MS2830 is selected in the Select instrument screen.

e ARB Memory Expansion (option) is not available for
MS269xA. Only Memory 256M samples, 1 GB is available.

m When using MG3700A or MS2830A

Select whether the ARB memory expansion option 256Msamples is
installed. Selecting With Option21 (Memory 512M samples)/With
Option27 (Memory 256M samples) supports creation of larger
waveform patterns. If the ARB memory expansion option is not
installed, the generated waveform pattern may not be able to be
used. Waveform patterns cannot be created with a size greater than
256Msamples or 64M samples when Without Option21 (Memory
512M samples)/Without Option27 (Memory 256M samples) is
selected. Select either according to the presence of ARB memory
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expansion option.

Table 3.2.1-1 Available Options for MG3700A or MS2830A

Model Items ARB Men.10ry
Expansion
With Option21 (Memory 512M |1 GB x 2
samples) memory
MG3700A
Without Option21 (Memory 512 MB x 2
512M samples): Memories
With Option27 (Memory 256M
samples) 1GB
MS2830A
Without Option27 (Memory 956 MB
256M samples)
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Chapter 3 Detailed Description of Functions

m When using MG3710A

The presence/absence of the ARB Memory Expansion (option) and
Baseband Signal Combination Function (option) is selected.
Selecting the ARB Memory Expansion (option) and the Baseband
Signal Combination Function (option) generates a bigger waveform
pattern, while selecting the Baseband Signal Combination Function
(option) generates a waveform pattern. If an uninstalled option is
selected, sometimes the created waveform pattern may not be
usable.

Set the combination of installed options based on the following
setting items.

Table 3.2.1-2 Available Options for MG3710A

Items Combinations of Options

Memory 64M samples None

Option48
Memory 64M samples X 2 and
Option 78

Option45
Memory 256M samples or
Option 75

Option 45 and Option 48
Memory 256M samples X 2 or
Option 75 and Option 78

Option46
Memory 1024M samples or
Option 76

Option 46 and Option 48
Memory 1024M samples X 2 or
Option 76 and Option 78

The maximum size of the generated waveform pattern for each of
the setting items is shown below.

Table 3.2.1-3 Waveform Pattern Maximum Size

Items Maximum Size

Memory 64M samples 64M samples

Memory 64M samples x 2 (With
Option48, 78)

Memory 256M samples 256M samples

Memory 256M samples x 2 (With
Option48, 78)

Memory 1024M samples 512M samples

Memory 1024M samples x 2 (With
Option48, 78)

128M samples

512M samples

512M samples
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3.2 Uplink Setup Screen

e Recall Parameter File
Sets the HSDPA/HSUPA Uplink parameters according to the

setting of the parameter files saved by Save Parameter File.

e Save Parameter File
Saves the HSDPA/HSUPA Uplink setting parameters to a file.

o Exit
Exits the HSDPA/HSUPA Uplink I1Qproducer™,

m Edit menu

The Edit menu contains the following items.

TN Transfer Setting

Channel Edit
Channel Gain Setup
HSUPA Edit

Calculate Wawveform Pattern

Figure 3.2.1-3 Screen when Edit is selected

¢ Channel Edit
Displays the Channel Edit screen in which the DPCH parameters
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are set. This is the same operation as that which occurs when Edit

in the upper right part of the screen is clicked.

e Channel Gain Setup
Displays the Channel Gain Setup screen in which the power of each
channel can be set using Bc, Bd, and other parameters. The setting
of Power in the main screen is changed in accordance with the

channel power set in this screen.

e HSUPA Edit
Displays the HSUPA Edit screen in which the HSUPA parameters
are set. This is the same operation as that which occurs when Edit
in the lower right part of the screen is clicked.
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Calculate Waveform Pattern

Starts waveform pattern generation based on the settings on the
screen.

The number of frames to be generated varies depending on the
setting conditions for each channel, and the time required for
generating a waveform pattern also varies accordingly.

The number of frames to be generated is displayed on the
calculation progress screen.

Refer to Appendix B “Number of Frames to Be Generated” for
details on the number of frames to be generated in accordance with
the Uplink setting conditions.

e Calculation & Load

Note:
This function is available only when this software is used on
MG3710A.

After waveform generation is finished, the created waveform
pattern is loaded into the MG3710A waveform memory.

e Calculation & Play

Note:
This function is available only when this software is used on
MG3710A.

After waveform generation is finished, the created waveform pattern is
loaded and selected at the MG3710A waveform memory.
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3.2 Uplink Setup Screen

m Transfer Setting menu
The Transfer Setting menu contains the following items.

Transfer Setting

Transfer Setting Wizard |

Figure 3.2.1-4 Transfer Setting menu

e Transfer Setting Wizard
Note:
This function is available only when MG3700 or MG3710 is
selected in the Select instrument screen.

Displays the Transfer Setting Wizard screen. Every operation ranging
from connecting the PC and MG3700A or MG3710A and transferring
the waveform pattern to the MG3700A or MG3710A, to loading the
waveform pattern into the MG3700A or MG3710A ARB memory is
performed at this screen.

m Tool buttons
The following tool buttons are provided.
Notes:
e Transfer&Setting Wizard is available only when MG3700 or
MG3710 is selected in the Select instrument screen.
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e C(Calculation & Load and Calculation & Play are available
only when this software is used on MG3710A.

Recall Parameter File

Save Parameter File
Calculate Waveform Pattern
Calculation & Load
Calculation & Play

Transfer & Setting Wizard

Exit

@E\E@t %5

Clicking a tool button operates the same as the corresponding

commands in the menu.

3-61



Chapter 3 Detailed Description of Functions

B Normalize Power button

MHormalize Power

Figure 3.2.1-5 Normalize Power button

When this button is clicked, Total Power is subtracted from the power
of each channel that is set to ON. As a result, the total power is
normalized to O dB while retaining the power ratio of the channels
that are set to ON.

Since normalization is automatically executed if necessary at the start
of waveform pattern generation, it is not always required to execute
normalization manually by clicking the Normalize Power button. This
button may be used for pre-check before waveform pattern generation.
For normalization of HS-DPCCH, the greatest from among the ACK
power, NACK power, and CQI power is used for calculation. Therefore,
the average power value obtained by measuring the RF output level
with a power meter does not match the setting level of the
MS2690A/MS2691A/MS2692A or MS2830A unless the ACK_power,
NACK_power, and CQI_power for HS-DPCCH are the same and do not
include DTX (see Figure 3.2.1-6).

For E-DPDCH(s), the power can be set for each E-DCH TTI, using an
HARQ process setting file. Refer to the descriptions of E-DPCCH and
E-DPDCH in Section 3.2. “Uplink Setup Screen” and see Figure 3.2.1-
for details on the power of E-DPDCH(s) for each E-DCH TTI.
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NACK
ACK Power

Power CQl Power CQl Power

E-DPDCH(s) Power

E-DPCCH Power

UL-DPDCH Power

UL-DPCCH Power

Figure 3.2.1-6 Channel powers and RF output level after normalization
when HS-DPCCH level is variable

Range where E-DPDCH(s) Power is set to 0 dB
by HARQ Process Setting File

E-DPDCH(s) Power
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ACK CQl Power NACK CQI Power
Power Power

E-DPCCH Power

UL-DPDCH Power

UL-DPCCH Power

Figure 3.2.1-7 Channel powers and RF output level after normalization
when E-DPDCH(s) level is variable
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3.2.2 Details of setting parameters on main screen

Setting Item

Scrambling Code

Functional Outline

Sets the scrambling code.

Setting Parameters

Setting Range

0 to 16777215

Setting Item

Number of Frames

Functional Outline

Sets the number of frames to be generated.

Setting Parameters

Setting Range

Number of 1 to the maximum number of frames for the waveform
Frames memory
Auto Check box selected or cleared.

Details

Refer to Appendix B for the maximum number of frames for the waveform

memory

When Auto is selected, it automatically calculates the necessary number of
frames for waveform generation, and generates the waveform pattern

accordingly.
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3.2 Uplink Setup Screen

Setting Item

UL-DPCCH, UL-DPDCH

Functional Outline

Performs settings for DPCCH and DPDCH.

Setting Parameters

Setting Range

Channel ON/OFF ON or OFF
Power —40.00 to 0 [dB], setting resolution: 0.01 dB
Data RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/

RMC 384 kbps/AMR1/AMR2/AMRS3/ISDN/
64 kbps Packet/User Edit TrCH

Nmax-dpdch 0,1

Details

RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/RMC 384 kbps

Each channel coding parameter of the DCH is set according to the standard
format selected by Data.

Refer to 3GPP TS25.104 Annex A UL reference measurement channel for
details of these channels. See the next and subsequent pages for details of
each parameter.

AMR1/AMR2/AMR3/ISDN

Refer to 3GPP TR25.944 4.1.2.2 Example for DCH for details of these
channels. See the sections below for details of DTCH, DCCH, and
Multiplexing.

DTCH

AMRI: 4.1.2.2.1.2 Example for 12.2 kbps data (TFS =#1)
AMRZ2: 4.1.2.2.1.2 Example for 12.2 kbps data (TFS = #2)
AMRS3: 4.1.2.2.1.2 Example for 12.2 kbps data (TFS =#3)
ISDN: 4.1.2.2.1.6 Example for 64 kbps data

DCCH
AMRI/AMRZ/AMRS/ISDN: 4.1.2.2.1.1 Example for 3.4 kbps data

Multiplexing
AMRI/AMRZ/AMRS: 4.1.2.2.2.2 Example for multiplexing of 12.2 kbps data
and 3.4 kbps data
ISDN: 4.1.2.2.2.5 Example for multiplexing of 64 kbps data and 3.4 kbps data

User Edit TrCH

In this setting, the settings of parameters for TrCH can be changed on the
Channel Edit screen that is opened by clicking the Edit button. Select User
Edit TrCH when setting a channel other than the standard transport
channels described above.

Nmax-dpdch

The maximum number of UL DPDCHs can be set, from O or 1 in this
software. Ch Code of HS-DPCCH and Ch Code and IQ mapping of E-DPDCH
depend on this setting. Refer to the descriptions of HS-DPCCH, E-DPCCH,
and E-DPDCH in this section.
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Chapter 3 Detailed Description of Functions

¢ UL_RMC_12_2 kbps channel coding parameters

Table 3.2.2-1 UL reference measurement channel 12.2 kbps
physical channel parameters

Parameter Unit Level
Information bit rate kbps 12.2

DPDCH kbps 60

DPCCH kbps 15

DPCCH Slot Format #I - 0
DPCCH/DPDCH power ratio dB -2.69

TFCI - On

Repetition % 22

Table 3.2.2-2 UL reference measurement channel 12.2 kbps
transport channel parameters

Parameter DTCH DCCH
Transport Channel Number 1 2
Transport Block Size 244 100
Transport Block Set Size 244 100
Transmission Time Interval 20 ms 40 ms
Type of Error Protection Convolution Coding Convolution Coding
Coding Rate 1/3 1/3
Rate Matching attribute 256 256
Size of CRC 16 12
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3.2 Uplink Setup Screen

DTCH DCCH

40 40 uuu. 40 40 40 eeer 40 40 40 e+ 40 40 40 eeee 4O

ekbps DPDCH (1 [ 2 [ eeee [5|f1[2] oo [M5])[1[2] eeee [15)[ 1] 2] «eev [15]

Information data 244 Information data 100
CRC16,
CRC attachment 244 4 CRC attachment 100 .
Tails CRC'121;8”8
Tail bitatiachment 260 Tail bit attachment 112 ]
Conv. coding R=1/3 804 ] Conv. coding R=1/3 360 3
1st intedeaving 804 1stinterleaving 360
o | #1 402 # 402 %0 [90 [%0 [ % g
o)
[ Y
Rate matching #1 490 # 490 | #1490 | # 490 | 110 | 110| 110 | 110 g
&
490 110 490 | 110 49 |10 49 110 8
2nd interleaving E
600 600 600 600 o,
slot segmentation IE Il IE g
=y
=
o
=
Q
=
o
=}
w

4+—r4—p
Radio frame FN=4N Radio frame FN=4N+1 Radio frame FN=4N+2 Radio frame FN=4N+3

Figure 3.2.2-1 Channel coding for UL reference measurement channel 12.2 kbps
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¢+ UL_RMC_64 kbps channel coding parameters

Table 3.2.2-3 UL reference measurement channel 64 kbps

physical channel parameters

Parameter Unit Level
Information bit rate kbps 64
DPDCH kbps 240
DPCCH kbps 15
DPCCH Slot Format #I - 0
DPCCH/DPDCH power ratio dB -5.46
TFCI - On
Repetition % 19

Table 3.2.2-4 UL reference measurement channel 64 kbps

transport channel parameters

Parameter DTCH DCCH
Transport Channel Number 1 2
Transport Block Size 2560 100
Transport Block Set Size 2560 100
Transmission Time Interval 40 ms 40 ms
Type of Error Protection Turbo Coding Convolution Coding
Coding Rate 1/3 1/3
Rate Matching attribute 256 256
Size of CRC 16 12
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DTCH DCCH

160160  +.s. 160160160 - 160160160 <++++ 160160160 <+++ 160

| ] |

240kbpsDPDCH|1|2| |15||1|2| |15||1|2| |15||1|2| |15

» » < » < »
» % » €

Radio frame FN=4N Radio frame FN=4N¢1 Radioframe FNe4N+2  Radio frame FN=4N+3

Information data 2560 Information data 100
URCTZ
CRC attachment 2560 - CRC16 CRC attachment 100
Tailg
2576 Tail bit attachment 112 /|
h . Ternination 12
Turbo Code R=1/3 7740 Conv. coding R=1/3 360 3
1st interleaving 7740 Tstinterleaving 360

it | #11935 | #2193 | #3193 | # 1935 90 [ 90 [ 90 [ % g
)
e o
Rlemaching [ #1 2203 | #2 2293 | #3 2293 | #4 2203 107 | 107 ] 107 | 107 3
%
2293 |107 2293 |107 2293 |107 2293 |107 @
2nd interleaving E
2400 2400 2400 2400 S
slot segmentation IE Il IE g
=N
)
g
aQ
=8
=
wn

Figure 3.2.2-2 Channel coding for UL reference measurement channel 64 kbps
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¢ UL_RMC_144 kbps channel coding parameters

Table 3.2.2-5 UL reference measurement channel 144 kbps

physical channel parameters

Parameter Unit Level
Information bit rate kbps 144
DPDCH kbps 480
DPCCH kbps 15
DPCCH Slot Format #I - 0
DPCCH/DPDCH power ratio dB -9.54
TFCI - On
Repetition % 8

Table 3.2.2-6 UL reference measurement channel 144 kbps

transport channel parameters

Parameter DTCH DCCH
Transport Channel Number 1 2
Transport Block Size 2280 100
Transport Block Set Size 5760 100
Transmission Time Interval 40 ms 40 ms
Type of Error Protection Turbo Coding Convolution Coding
Coding Rate 1/3 1/3
Rate Matching attribute 256 256
Size of CRC 16 12
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DTCH

DCCH

Information data 2880 2880 Information data 100
f‘/l f‘1Q r‘Pf‘1Q CRCTY
CRC attachment 2880 /| 2880 i/ CRC attachment 100
Tail8
5792 Tail bitattachment 112 /|
Termination 2x12
Turbo Code R=1/3 17400 Conv. coding R=1/3 360 3
1st interleaving 17400 1stinterleaving 360
i | #1 4350 | #4350 | #3 4350 #4350 #1 90[#2 90[#3 90#4 90 g
&
Rate matching #4702 #4702 | #3 4702 #4702 #1 98|#2 98|#3 98|#4 98 ;:
&
4702 | 98 4702 | 98 4702 | 98 4702 | 98 @
2nd interleaving 5
4800 4800 4800 4800 g
slot segmentation IE II IE g
320320 eees 320320320 ++++ 320320320 e+ 320320320 e+ 320 ;
g
480kbpsDPDCH|1|2| ceee |15||1|2| ceee |15||1|2| ceee |15||1|2| ceee |15| g,_
o
Radio frame FN=4N Radio frame FN=4N+1 Radio frame FN=4N+2 Radio frame FN=4N+3 g

Figure 3.2.2-3 Channel coding for UL reference measurement channel 144 kbps
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¢ UL_RMC_384 kbps channel coding parameters

Table 3.2.2-7 UL reference measurement channel 384 kbps

physical channel parameters

Parameter Unit Level
Information bit rate kbps 384
DPDCH kbps 960
DPCCH kbps 15
DPCCH Slot Format #I - 0
DPCCH/DPDCH power ratio dB -9.54
TFCI - On
Puncturing % 18

Table 3.2.2-8 UL reference measurement channel 384 kbps

transport channel parameters

Parameter DTCH DCCH
Transport Channel Number 1 2
Transport Block Size 3840 100
Transport Block Set Size 15360 100
Transmission Time Interval 40 ms 40 ms
Type of Error Protection Turbo Coding Convolution Coding
Coding Rate 1/3 1/3
Rate Matching attribute 256 256
Size of CRC 16 12
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DTCH DCCH

640640 .... 640640640 cce+ 640640640 e+ 640640640 640

960kbpsDPDCH|1|2| |15||1|2| |15||1|2| |15||1|2| |15

» < » < »
» %

Radio frame FN=4N Radio ffame FN=4N+{  RadioframeFNe4N+2 ~  Racio frame FN=4N+3

Information data 3840 ¥ Iformation data 100
= _@S# CRC12
CRC attachment Y CRC16 CRC attachment 100 'r
Tail8
i Tail bit attachment 112 /|
", Termination4x12 e
Turbo Code R=1/3 46320 -] Conv. coding R=1/3 360 3
1st interleaving 46320 Tstinterleaving 360
Raofrane e T g 11530 [ # a0 | # H150 9072 0] 904 90 S
segmentation i i | | | T
&
o
Rate matching #1 9525 | #2 9525 || #3 9525 | #4 9525 #1 75|#2 75|#3 75|#4 75 g
%
9525 | 75 9525 | 75 9525 | 75 9525 | 75 @
2nd interleaving E
9600 9600 9600 9600 o
slot segmentation IE Il IE g
=
£
ot
(=
Q
=8
@]
=]
7

Figure 3.2.2-4 Channel coding for UL reference measurement channel 384 kbps
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Setting Item

HS-DPCCH

Functional Outline

Performs settings for HS-DPCCH.

Setting Parameters

Setting Range

ON/OFF ON or OFF

Timing Offset 0 to 149

ACK_Power —40.00 to 0 [dBI, setting resolution: 0.01 dB
NACK_Power —-40.00 to 0 [dBI, setting resolution: 0.01 dB
CQI_Power —-40.00 to 0 [dB], setting resolution: 0.01 dB
ACK Pattern ACK _only, NACK _only, alt. ACK_NACK_DTX
CQI value 0 to 30

Pattern Setting File Use or Not use

Details

[Timing Offset]

The output timing difference of HS-DPCCH from DPCCH is set with the
setting resolution of 256 chips. When “1” is set, HS-DPCCH is output behind
DPCCH by 256 chips.

[ACK_Power, NACK_Power]

The transmission power of the HARQ-ACK field for HS-DPCCH is set to the
ACK_Power set value in ACK transmission, and set to the NACK_Power set
value in NACK transmission.

[CQI_Power]
The transmission power of the CQI field for HS-DPCCH is set.

Refer to the description of the Normalize Power button in this section for
normalization executed when the Normalize Power button is pressed.

[ACK Pattern]

ACK_only, NACK_only, and alt_ACK_NACK_DTX indicate “transmitting
ACK only,” “transmitting NACK only,” and “transmitting ACK, NACK, and
DTX by rotation,” respectively.
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Details (Cont'd) [Pattern Setting File]

When this check box is selected, the “Open file” screen is displayed to select a
text file with extension “.txt” to be read for setting the transmission pattern
of HS-DPCCH.

When Pattern Setting File is selected, the setting of ACK Pattern is invalid.

The following shows a pattern setting file format example:

#MX269901A HSDPA/HSUPA I@Qproducer HS-DPCCH Pattern Setting File
Pattern Cycle = 6 frame

AOONOODOODOODOO

A01A01A01A01A01

N3ON3ON3ON3ON30

DI99D99DIIDIIDIY9

AOONOODOODOODOO

A01A01A01A01A01

3

Error judgment and error display are performed during file reading with the

following conditions:

(1) Pattern cycle: 1, 2, 3, ..., 2048 frames
Sets the period of the HS-DPCCH pattern in frame units.

(2) For each HS-DPCCH pattern number (number other than the pattern
cycle), one subframe is represented by a combination of three characters:
o, o, and B1.
a: A (ACK), N (NACK), or D (DTX)
Bop1: CQI number 00, 01, 02, ..., 30, 99 (“99” indicates DTX.)

(3) Although each line is fed by 15 characters (1 frame) in the example
above, commas (,), periods (.), spaces, and line feed characters are
ignored.

suorjoun,f Jo uorpdrIosa(] parreroq

[Ch Code of HS-DPCCH]
Ch Code of HS-DPCCH is set depending on the Nmax-dpdch value, as shown
in the table below:

Table Ch Code of HS-DPCCH

N max-dpdch Channelization code G,
0 C ch,256,33
1 C ch,256,64
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Setting Item

E-DPCCH, E-DPDCH

Functional Outline

Performs settings for E-DPCCH and E-DPDCH(s).

Setting Parameters

Setting Range

Channel ON/OFTF for ON or OFF

E-DPCCH

Channel ON/OFF for ON or OFF

E-DPDCH(s)

Power of E-DPCCH —40.00 to 0 [dBlI, setting resolution: 0.01 dB
Power of E-DPDCH(s) —40.00 to 0 [dB], setting resolution: 0.01 dB
E-DPDCH(SF2) Power/ —-10.00 to 10.0 [dB], setting resolution: 0.01 dB
E-DPDCH(SF4) Power

Details

[Channel ON/OFF for E-DPCCH, Channel ON/OFF for E-DPDCH(s)]

The channel On/Off can be set. If this parameter is set to Off, the
corresponding channel becomes Off regardless of the set value (On/Off)
described in the HARQ process setting file.

[Power of E-DPCCH]
The channel gain of E-DPCCH is set.

[Power of E-DPDCH(s)]

The channel gain of E-DPDCH(s) is set. If E-DPDCH(s) is a multi-code
(2SF2, 2SF4, or 2SF2and 2SF4), the total power of E-DPDCH channels
corresponds to the value set by this parameter.

The channel gain of E-DPDCH(s) can be set for each E-DCH TTI by using an
HARQ process setting file. In this event, E-DPDCHs are multiplexed by the
power ratio shown below.

(i) E-DCH TTI when E-DPDCH(s) Gain is set to 0 dB in the HARQ process
setting file
The E-DPDCHs are multiplexed by the power ratio set in Power of
E-DPDCH(s) in the main screen.

(i) E-DCH TTI when E-DPDCH(s) Gain is set to a value other than 0 dB in
HARQ process setting file
The E-DPDCHs are multiplexed by the power ratio obtained by adding
“Power of E-DPDCH(s) set in the main screen” and “Power of E-DPDCH(s)
set in the HARQ process setting file.”

[Ch Codes of E-DPDCH(s)]

The channelization code of E-DPDCH is displayed. When HARQ Process
Setting File is set in the HSUPA Edit screen, Ch Code of E-DPDCH is not
displayed on the main screen.

[Ch Code of E-DPCCH, Ch Code of E-DPDCH]

The channelization code of each channel is displayed. The channelization
codes can be set by editing E-DPDCH Channel Code in the HSUPA Edit
screen (opened by clicking the Edit button on the main screen). When an
HARQ process setting file is used, it can also be set by editing
Channelization Codes of the HARQ process setting file.
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Details (Cont'd) 1Q mapping of E-DPDCH is set depending on the settings of HS-DSCH
Configured and Nmax-dpdch, as shown in the table below. Note, however,
that the same number of E-DPDCHs are mapped to IQ if the Ch Code of
E-DPDCH is set to 2SF2, 25F4, or 2SF2and2SF4.

Table 1Q mapping of E-DPDCH
(except the cases when Ch Code is 2SF2, 2SF4, or 2SF2and2SF4)

HS-DSCH .
N gpicn configured IQ mapping
0 No/Yes 1 3
1 No
1 Yes I

E-DPCCH is mapped to the I phase.

[E-DPDCH(SF2) Power/E-DPDCH(SF4) Power]

The power ratio of SF2 E-DPDCH to SF4 E-DPDCH when 2SF2and2SF4 is
selected is set.
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3.2.3 Details of setting parameters on Channel Edit screen
When the Edit button is clicked, the Channel Edit screen shown below is

displayed. This section describes the details of the setting items on this

screen.

X
DPCH Edit
PhyGH
UL-DFDGH Data [TGH =] R | %
TRl i = UL-DPOCH Slot Format [0 <]
UL-DPDCH Spreadine Factor [64 - Timing Offset 0 = TPG Edit |
TrGH
Essy Setup_| TCH Number  [2 =]
4| | »
TrGHI TrGH2 TroHa TrCHY
Data | |PNBfix = | [Prsfic = | = F =
T | [oms 7] [soms =] E il I- S|
Max TrBk Size | [244 hit 100 hit F bit F bit
TrBk Size | 244 bit 100 hit F bit F bit
Max TrBk Set No. | TeBk* [i Trekx I ek TEkx
TeEk Set Mo. | TiBk* [T Trekx I ek ek Fo
GRG | [16bit ] (T |- = |- =l
Coder | [cC1/3 7] jccisi x| |- =l |- =l
RM attribute [es6 Jese F— F
BeR | F— F— F—
Ber | [ F F F—
Gancel |
Figure 3.2.3-1 Channel Edit screen

B When setting the User Edit TrCH in Data, it is possible to apply the

transport channel settings of the standard pattern by pressing the

Easy Setup button so as to facilitate an editing operation.

B OK and Cancel buttons

The OK and Cancel buttons are provided to close the Channel Edit

screen after performing setting.

e When the OK button is clicked:

The Channel Edit screen is closed, applying the settings.

e When the Cancel button is clicked:

The Channel Edit screen is closed, ignoring the settings.




3.2 Uplink Setup Screen

Setting Item DPCH Edit (PhyCH)
Functional Outline Performs settings for UL-DPCH.
Setting Parameters Setting Range
UL-DPDCH Data PN9/PN9fix/PN15fix/16 bitRepeat/TrCH
TFCI 0 to 1023
UL-DPDCH 4, 8,16, 32, 64, 128, 256
Spreading Factor
BER 0.0 to 100.0%, setting resolution: 0.1%
UL-DPDCH Slot #0 or #1 3
Format
Timing Offset 0 to 149
TPC Edit 0000 0000 0000 0000 0000 0000 0000 0000 0000
0000 0000 0000 0000 0000 0000 to
111111111111 1111 1111 1111 1111 1111 1111
111111111111 1111 1111 1111
Details [UL-DPDCH Data]

Selects the data to be inserted to UL-DPDCH of the physical channel.
PNOfix/PN15fix is PN9/PN15 data reset by each frame. PN data is not
continuous between frames. When performing operations such as BER (Bit
Error Rate) measurement for a reception sensitive test, select PN9 with
which PN data is continuous between frames.

When TrCH is selected, a physical frame structure is configured for DPDCH
and DPCCH and the data for which DCH frame coding is executed is
inserted to DPDCH.

[UL- DPDCH Slot Format, TPC Edit]
These settings are enabled only when UL-DPDCH Data is set to TrCH.

[BER]

Sets the error rate to be inserted to the transmission data.

This setting is valid when UL-DPDCH Data is set to PN9.

When UL-DPDCH Data is set to [PN9], an error is randomly inserted to the
PN9 data that is inserted directly to a physical frame.

[Timing Offset]
Sets an offset for the frame timing with a value of 256 chip multiplied by n.

[TPC Edit]

Sets the data to be inserted to the TPC bit in a 4-frame cycle. Each bit
indicates the symbol (0/1) of the TPC bit to be assigned to each slot. Data is
assigned to each slot sequentially from the left.
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Setting Item

DPCH Edit (TrCh)

Functional Outline

Performs settings for TrCH of UL-DPCH.

Setting Parameters

Setting Range

TrCH Number 1to8

Data PN9/PNO9fix/PN15fix/16 bitRepeat/User File
TTI 10, 20, 40, 80 ms

Max. TrBk Size 0 to 5000

TrBk Size 0 to 5000

Max. TrBk Set No. 0 to 64

TrBk Set No. 0 to 64

CRC 0, 8, 12, 16, 24 bits

Coder CC1/2, CC1/3, TC

RM attribute 1 to 256

BER 0.0 to 100.0%, setting resolution: 0.1%
BLER 0 to 100%, setting resolution: 1%

Details

[TrCH Number]
Sets the number of required TrCH (transport channels). The number of TrCh
that can be edited varies depending on this setting.

[Data]

Selects the data to be inserted to Information Data of the transport channel.
PNOfix/PN15fix is PN9/PN15 data reset at the last data of a signal. The last
data of a signal and the first data of the next signal are not continuous.

[Max. TrBk Size], [Max. TrBk Set No.]
Sets the maximum TrBk Size and the number of TrBk Sets in TFCS.

[Coder]
Selects the channel coding type. CC1/2 and CC1/3 indicate a convolutional
code at coding rates of 1/2 and 1/3 respectively. TC indicates a turbo code.

[BER]

This setting is valid when Data is set to PN9. The bits in the information
data to be inserted to the transport channel are randomly inverted according
to the specified error rate.

[BLER]

This setting is valid when Data is set to PN9. Half of the bits in the CRC to
be added to each transport block are inverted randomly according to the
specified error rate.
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3.2.4 Details of setting parameters on HSUPA Edit screen
When the Edit button in the E-DPDCH(s) frame or the E-DPCCH button

on the main screen is clicked, the HSUPA Edit screen shown below is
displayed. This section describes the details of the setting items on this

screen.

HSUPA Edit Xl

PhyGH
[~ HARD Process Setting File | |

E-DPCCH Data IGoded vl H5-D3CH Configured Ha i
E-DPOCH Data E-DCH - E-DFDGH Channel Godes SFA4 =

TrizH
E-DGH TTI IM vl Pattern Leneth |5
Information Bit Pavload I‘IS E-DCH Ry Index ID vI
E-DCH Payload Data  [FMO - GRG Error Inzertion Im
E-TFCI Infarmation ID “Happy™ Bit ID "I

RSN [0 -
Cancel _|

Figure 3.2.4-1 HSUPA Edit screen
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B OK and Cancel buttons
The OK and Cancel buttons are provided to close the HSUPA Edit

screen after performing setting.

e When the OK button is clicked:
The HSUPA Edit screen is closed, applying the settings.

e When the Cancel button is clicked:
The HSUPA Edit screen is closed, ignoring the settings.
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Setting Item

E-DPDCH and E-DPCCH Edit (PhyCH)

Functional Outline

Performs settings for Physical Layer E-DPDCH and E-DPCCH.

Setting Parameters

Setting Range

HARQ Process Setting When this check box is selected, the common

File dialog box is displayed and an HARQ process
setting file to be used can be selected.

E-DPCCH Data PN9, PN9fix, PN15fix, 16bit repeat, Coded

E-DPDCH Data PN9, PN9fix, PN15fix, 16bit repeat, E-DCH

HS-DSCH Configured No, Yes

E-DPDCH Channel SF256, SF128, SF64, SF32, SF16, SF8, SF4,

Codes 2SF4, 2SF2, 2SF2and2SF4

Note that 2SF2and2SF4 cannot be selected when
Nmax-dpdch is set to 1, and SF256 and SF128
cannot be selected when E-DCH TTI is set to 2
ms.

Details

[HARQ Process Setting File]

When an HARQ process setting file is used, all of the other parameter
settings in the HSUPA Edit screen are invalid, and the values described in
the HARQ process setting file are set to the E-DPDCH and E-DPCCH
parameters.

[E-DPCCH Data]

When PN9, PN9fix, PN15fix, or 16bit repeat is selected, the selected data is
mapped to E-DPCCH, without being coded.

When Coded is selected, the data that is coded according to the setting of
TrCH is mapped to E-DPCCH.

[E-DPDCH Data]

When PN9, PN9fix, PN15fix, or 16bit repeat is selected, the selected data is
mapped to E-DPDCH and diffused, without being coded.

When E-CDH is selected, the data set in E-DCH Payload Data of TrCH is
channel-coded and mapped to E-DPDCH.

[E-DPDCH Channel Codes]

Sets Ch Code of E-DPDCH. Note that 2SF2and2SF4 cannot be selected when
HS-DSCH Configured is set to Yes. When 2SF2 is selected, a channel of SF2
E-DPDCH is mapped to each of phases I and Q. When 2SF4 is selected, a
channel of SF4 E-DPDCH is mapped to each of phases I and Q. When
2SF2and2SF4 is selected, a channel of SF2 E-DPDCH and a channel of SF4
E-DPDCH are mapped to each of phases I and Q (four channels are mapped
in total).
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Setting Item E-DPDCH and E-DPCCH Edit (TrCH)
Functional Outline Performs settings for transport layer of E-DPDCH and E-DPCCH.
Setting Parameters Setting Range
E-DCH TTI 2 ms, 10 ms.
Pattern Length Display only.
“5” 1s displayed when E-DCH TTI is set to 2 ms.
“1” 1s displayed when E-DCH TTI is set to 10 ms.
Information Bit 18 to 11484 (when E-DCH TTI is set to 2 ms.)
Payload 18 to 20000 (when E-DCH TTI is set to 10 ms.)
E-DCH RV Index 0to3
E-DCH Payload Data PN9, PN9fix, PN15fix, 16bit repeat
CRC Error Insertion Correct, Error
E-TFCI Information 0 to 127
“Happy” Bit 0,1
RSN 0to3
Details [Pattern Length]

“5” 1s displayed when E-DCH TTI is set to 2 ms, and “1” is displayed when
E-DCH TTI is set to 10 ms. Display only.

[Information Bit Payload]
Sets the length of E-DCH payload data.

[E-DCH RV Index]
Sets E-DCH RV Index. The value set in this parameter is applied to all
E-DCH RVs unless an HARQ process setting file is not used.

[CRC Error Insertion]
Sets whether to add an error CRC bit or a correct CRC bit to E-DCH. When
All Error is set, an error CRC bit is added to any E-DCH.

[E-TFCI Information]

Sets a value of E-TFCI Information, which is E-DPCCH data.
[“Happy” Bit]

Sets a value of “Happy Bit,” which is E-DPCCH data.

[RSN]
Sets a value of RSN, which i1s E-DPCCH data.
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3.2.4.1 HARQ Process Setting File

When an HARQ process setting file is used, payload data, Ch Code, and
other parameters of E-DPDCH and E-DPCCH can be set in detail for
each E-DCH TTI. Since HARQ process setting files are a csv-formatted
file, it can be edited and created using Microsoft Excel (see Figure
3.2.4.1-1) or a text editor (see Figure 3.2.4.1-2).

A [ B [ c ] D [ E | F [ G [ H [ 1
#ARG Process Setting File for 2ms E-DCH TTI

6 [H5-DSCH Configured M 3
7 |HARQ process 1 Data PhSfix &) DxF'FF HARG process 1 RV (Data Retrans) 0 =1

£ |HARQ process 2 Data PMN3fix 0xFFFF|HARQ process 2 RV (Data Retrans, [i] |

9 [HARQ process 3 Data PHSfix 0:FFFF|HARG process 3 RV (Data Retrans; [ |

10 |HARQ process 4 Data PMGfiz 0xFFFFIHARG process 4 RV (Data Retrans Io |

11 |HARQ process 5 Data PhSfis 0xFFFF|HARG process 5 RV (Data Retrans 0

12 |HARG process 6 Data PMSfix 0xFFFF|HARG process 6 RV (Data Retrans
13 |HARQ process 7 Data [STEE 0xFFFF|HARQ process ¥ RV (Data Retrans
14 [HARQ process § Data PMGfiz 0:xFFFF|HARQ process & RV (Data Retrans
5 [EDPDCH Ch Codes sF4 5F4 SFd SF4 SF4

| 16 |Information Bit Payload & 500 500 500 500 500
7 |E-DPDCH(s) Gain 0.00 0.00 0.00 0.00
|8 |SF2 E-DPDCH /SF4 E-DPDCH it 3.0 3.01 301 301 301
8 |CRC Error Insertion Correctil Cotrect Correct Correct Correct

20 |E-DPCCH ON/OFF Okl ely] Dk oy ] [oly]

21 |RSH Value 0 a a i}
22 |E-TFCl Info.
| 23 "Happy" bit
24 |E-DPCCH Gain Factor

| 25 [Pattern Length 12

4 4 4 4
kel
o
=
[=]

0.00

A4 444

4[4 [ 2me TTI{10me TTI/

Figure 3.2.4.1-1 Editing HARQ process setting file using Microsoft Excel

BHERD Process Setting File for 2ms E-DCH TTL, oy uunsusssrssssrsssrsrsnssrssnnsssssrssssssssssnsnrsrsasnsrssssrrssssssss o

E-DCH TTL, s 25, 5y s sasssasssssssnrsansssssssossarssarssssssnsssarsasssssssssssarssarssssssssssarsansssssssrssssssas

#.,,.1.2,3,4,5,6,7,8,9,10,11,12,13,14,15,16,17,18,19,20,21,22,23,24,25,26,27,28,29,30,31,32,33,34,35,36,37,38,39,40,4
E-DPDCH ONAOFF, , , , ON, ON, ON, ON, ON, ON, 0K, ON, ON, ON, OR, ON, 0N, ON, ON, O, O, O, ON, 0N, ON, ON, OF, OW, O, OWL ON, ON, OR, ONL N, O, ON,
HS-DSCH Conf iaured, oy sNOL s v s s s vssvs v ssassasassasassasassssansssassssansssanssnanssssnsnssssnssnsnsssssssssssinssasins
HARD process 1 Data,PNST ix, 0xFFFF,HARD process 1 RY (Data Retrans),0u,ayesssDanss s 0avvans s 0sssansDhaa s na0h 0y
HARD process 2 Data,PNST ix, DxFFFF, HARD process 2 RY (Data Retrans), . 0,ayesssnOavssens0isans s Ouasan s Daa s ean 0y
HARD process 3 Data,PNST ix, DxFFFF, HARD process 3 RY (Data Retrans),..0.vuuusu0ssssss0ausssn0nnansn0us a0y,
HARD process 4 Data, PNST ix, DxFFFF,HARD process 4 RY (Data Retrans),...0,.00s0s0osssssOuns s 0naus s 00s a0 04
HARQ process B Data, PHSf ix, 0xFFFF,HARD process B RY (Data Retrans).....0...vvon 0o Dhnn e O sl 04 00n s 0000
HARQ process 6 Data, PHSf ix, 0xFFFF,HARD process 6 RY (Data Retrans),.....0, .o ess0snenn0n e Do ne s 00 s 0
HARQ process 7 Data,PNSf ix, 0xFFFF,HARD process 7 RY (Data Retranz),......0....vven0vevennsOnvanenn 0o e 00 e
HARQ process & Data,PNOT ix, 0xFFFF, HARD process 8 RY (Data Retrans),.......0. .00 000esans0hanss s 0n s 00 sy
E-DFOCH Ch Codes, , ., SF4,5F4,5F4, 5F4,5F4,5F4, 5F4,5F4, 5F4, 5F4, SF4, SF4, SF4, SF4, SF4, 5F4, SF4, SF4, SF4, 5F4,5F4, 5F4, 5F4, 5F4, S
4,5F4

Information Bit Payload,,,,500 ,500 ,500 ,500 ,500 ,500 ,%00 ,%00 ,500 ,%00 ,5%00 ,%00 ,500 ,500 ,%00 ,500 %00 ,500 !
0,500 ,500 ,500 ,500 500 ,500 ,500 ,500 ,500 ,500 ,500 ,5%00 ,500 ,500 ,500 ,%00 ,500 ,%00 ,%00 ,%00 ,%00 ,500 500
E-DPOCH(=) Gain,,,.0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.
0 ,0.00 ,0.00 ,0.00 ,0.00,0.00,0,00,0.00,0.00,0.00 0,00 ,0.00,0.00,0,00,0,00,0,00,0.00,0.00,0.00,0.00 ,(
SF2 E-DPDCH / SF4 E-DPOCH, ,,,3.01 ,3.01 ,3.01 ,3.01 ,3.07 ,3.00 ,8.01 ,3.01 ,5.00 ,3.01 ,3.01 ,3.01 ,3.01 ,3.01 ,3.00
,3.01,3.01 ,3.01 ,3.01 ,3.01 ,3.01 ,3.01 ,3.01 ,%.071 ,3.01 ,3.01 ,3.01 ,3.01 ,3.07 ,3.07 ,3.01 ,3.01 ,3.01 ,3.01 ,3.(
CRC Error Insertion,...Correct,Correct,Correct,Correct,Correct,Correct,Correct,Correct,Correct ,Correct ,Correct,Correc
orrect,Correct,Correct,Correct,Correct,Correct,Correct,Correct, Correct ,Correct ,Correct, Correct,Correct . Correct . Correc
E-DPCCH OMAOFF, , ,, OM, ON, O, ON, ON, ON, OK, ON, ON, TN, OR, O, ON, ON, ON, OK, O, OK, ON, ON, OK, ON, OM, ON, OK, OW, ON, OM, ON, OM, ON, O, ON,

RSM ‘alue,,,,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0, (=
E-1FCI Info.,,,.0 ,0,0,0,0,0,0,0,0.,0,0,0,0,0,0,0.,0,0,0.,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0
“Happy”” bit”,,,.0 .0 .0 .0 .0 .0 .0 .0 .0 .0 .0 .0 .0 .0 ,0 .0 .0 .0 .0 .0 .0 .0 .0 .0 .0 .0 .0 .0 .0 .0 .0 .0 .0

E-DPCCH Gain Factor,,,,ﬂ 00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,0.00
,0.00 ,0.00 ,0.00 ,0.00 ,0.00 ,U.OU ,0.00 ,O.UU ,0.00 ,U.UU ,0.00 ,0.00 ,U.OU ,U.UU ,U.UU ,O.UU ,U.UO ,0.00 ,0.00 L0
Pattern Lenath, , o s 12, v s sy vssrsvnsrssasassasassasassasassssansssassssansssansssansaossnsnssssnssssnssssnssssnsissasins

R RN R R ]
-

1 [ | a7

Figure 3.2.4.1-2 Editing HARQ process setting file using text editor
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3.2 Uplink Setup Screen

The HSDPA folder is created in the IQproducer folder when this software
is installed, and an HARP process setting file HAR®) Process Setting
File.xls is stored in this folder. This file contains two types of reference
settings for 2 ms TTI and 10 ms TTI in separated sheets. Edit
parameters as required on the target sheet, and save the file in the csv
format before using it with this software. In addition to HARG) Process
Setting File.xIs, the HSDFPA folder also includes other HARP process
setting files: HARQ) process _setting FRCI. csv.xls through

HARQ process _setting FRC7. csv.xls. These files are used to facilitate
setting in accordance with E-DPDCH Fixed Reference Channel (FRC)
defined in 3GPP T'S25.141. These files are already saved in the csv
format, so they can be selected as HARQ process setting files as they are
(i.e., without conversion). Note, however, that the above files contain only
basic parameters.

Set an HARQ process setting file according to the table below.

Setting Item

HARQ Process Setting File

Functional Outline

Performs setting for E-DPDCH and E-DPCCH.

Setting Parameters

Setting Range

E-DCH TTI [1] 2 ms, 10 ms

E-DPDCH ON/OFF [2] ON, OFF

HS-DSCH Configured [3] Yes, No

HARQ Process 1 Data to PN9, PN9fix, PN15fix, 16bit repeat
HARQ Process 8 Data [4]

16 bit repeat value [5] 0x0000 to 0xFFFF

HARQ Process 1 RV (Data Retrans) 0,1, 2, 3, 0 (Retrans), 1 (Retrans), 2
to HARQ Process 8 RV (Data (Retrans), 3 (Retrans)

Retrans) [6]

E-DPDCH(s) Ch Codes [7] SF256, SF128, SF64, SF32, SF16, SF§,

SF4, 2SF4, 2SF2, 2SF2and2SF4

Note that 2SF2and2SF4 cannot be
selected when HS-DSCH Configured is
set to Yes, and SF256 and SF128 cannot
be selected when E-DCH TTI is set to 2

ms.

Information Bit Payload [8] 1 to 11484 (when E-DCH TTI = 2 ms)
1 to 20000 (when E-DCH TTI = 10
ms)

E-DPDCH(s) Gain [9] —20.00 to 20.00 dB, setting

resolution: 0.01 dB

SF2 E-DPDCH/SF4 E-DPDCH [10] —20.00 to 20.00 dB, setting
resolution: 0.01 dB

CRC Error Insertion [11] Correct, Error
E-DPCCH ON/OFF [12] ON, OFF
RSN Value [13] 0to3

E-TFCI Info. [14] 0to 127
“Happy” Bit [15] 0,1
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Chapter 3 Detailed Description of Functions

(Cont’d)
Setting Parameters | E-DPCCH Gain Factor [16] —20.00 to 20.00 dB, setting
resolution: 0.01 dB
Pattern Length [17] 1 to 2048
Details [E-DCH TTI]

Sets E-DCH TTI. In the sample Excel file, the HARQ process period when
E-DCH TTI is “2ms” is set to 8 subframes, and that when E-DCH TTI is
“10ms” is set to 4 frames.

[#]

Sets the E-DCH TTI number. Therefore, enter the subframe number when
E-DCH TTI is “2ms” and enter the frame number when E-DCH TTI is
“10ms.”

[E-DPDCH ON/OFF]

Set ON/OFF of E-DPDCH for each E-DCH TTI. Note, however, that
E-DPDCH is OFF for all frames regardless of this setting, if E-DPDCH is set
to OFF on the Uplink main screen.

[HS-DSCH Configured]

Sets HS-DSCH Configured. IQ mapping of E-DPDCH depends on this
setting. Refer to the descriptions of E-DPDCH and E-DPCCH in Section 3.2.2
“Uplink Setup screen.”

[HARQ Process 1 Data to HARQ Process 8 Datal

Sets payload data of E-DCH for each HARQ process. For example, when
HARQ Process 2 Data is set to “PN9fix,” the payload data of E-DCH for
E-DCH TTI, for which the value of RV is set by HARQ Process 2 RV (Data
Retrans), is

set to PN9. Similarly, when HARQ Process 2 Data is set to “PN15fix,” the
payload data of that HARQ process is set to PN15.

When “PN9fix” or “PN15fix” is selected, the PN code of the payload data is
not continuous. When “PN9” is selected, the E-DCH payload data of the
HARQ process is continuous PN9. When “16bit repeat” is selected, the bit
string set by [16 bit repeat value] is repeated and configures the payload
data.

[HARQ Process 1 RV (Data Retrans) to HARQ Process 8 RV (Data Retrans)]

Sets retransmission of the RV and payload of the HARQ process. For
example, when HARQ Process 2 RV is set to 1 while E-DCH TTI = 2ms and
[#] = 3, the HARQ Process 2 data is coded with RV = 1 for 3 subframes and is
output. When “(Retrans)” is suffixed to RV, the previous payload data that
was transmitted in the HARQ process (the data that was transmitted on the
left cell in the same row of the HARQ process setting file) will be
transmitted.

[E-DPDCH(s) Ch Codes]

Sets Ch Code of E-DPDCH. Note that 2SF2and2SF4 cannot be selected when
HS-DSCH Configured is set to Yes. When 2SF2 is selected, a channel of SF2
E-DPDCH is mapped to each of phases I and Q. When 2SF4 is selected, a
channel of SF4 E-DPDCH is mapped to each of phases I and Q. When
2SF2and2SF4 is selected, a channel of SF2 E-DPDCH and a channel of SF4
E-DPDCH are mapped to each of phases I and Q (four channels are mapped
in total).
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3.2 Uplink Setup Screen

(Cont’d)

Details (Cont'd) [Information Bit Payload]
Sets the length of E-DCH payload data.

Sets the power ratio of SF2 E-DPDCH and SF4 E-DPDCH when
2SF2and2SF4 is selected for E-DPDCH(s) Ch Codes.

[E-DPDCH(s) Gain]

The power that is obtained by adding the value set by this parameter as an
offset to the value set in Power of E-DPDCH(s) on the main screen becomes
the power of E-DPDCH(s) (or the total power of E-DPDCH channels if
E-DPDCH(s) is a multi-code).

[E-DPDCH(SF2) Power/ E-DPDCH(SF4) Power]

[CRC Error Insertion]

Sets whether to add an error CRC bit or a correct CRC bit. When “Error” is
set, 12 bits out of CRC 24 bits are inverted and added as a CRC bit.
[E-DPCCH ON/OFF]

Sets ON/OFF of E-DPCCH for each E-DCH TTI. Note, however, that
E-DPCCH is OFF for all frames regardless of this setting, if E-DPCCH is set
to OFF on the Uplink main screen.

[RSN Value]

Sets a value of RSN that is transmitted on E-DPCCH.

[E-TFCI Info.]

Sets a value of E-TFCI Information that is transmitted on E-DPCCH.
[“Happy” bit]

Sets a value of “Happy Bit” that is transmitted on E-DPCCH.

[E-DPCCH Gain]

The power obtained by adding the value set by this parameter is added as an
offset to the value set in Power of E-DPCCH on the main screen becomes the
power of E-DPCCH.

[Pattern Length]

Sets the pattern length for each E-DCH TTI. For example, when Pattern
Length is set to 8, a waveform pattern that consists of a repetition of data
corresponding to “1” through “8” in the [#] row is created for E-DPDCH and
E-DPCCH. The settings described in the [#] rows greater than Pattern
Length in the csv file are ignored and are not used during waveform pattern
generation.
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Chapter 3 Detailed Description of Functions

3.2.5 Details of setting parameters on Channel Gain Setup screen
When the Channel Gain Setup is selected from the Edit menu, the
Channel Gain Setup screen shown below is displayed. This section
describes the details of the setting items on this screen.
Note that the Channel Gain Setup screen cannot be opened if
UL-DPCCH is set to Off, or all Channels except for UL-DPCCH are set to

Off on the Uplink main screen.

Channel Gain Setup x|
DPGGH  Betac (-3.044E)
DPDCH  Betad a8 =] 3.04de
H-DPGGH

Delta ACK (Beta he/ Beta G} |1 GEAT 'I i-11.90dB}
Delta NAGK(Beta hs/ Beta Gl |1 G15) "'l i-11.90d87
Delta CAIBeta hed Beta G |1 B8 "I -11.90dE}

E-DP GG HBeta ecs Beta G |1 WGA1E) 'l -11.904E%
E-DPDGH{Beta ed, k/Beta ) |1 G183 v| (-11.904E}

Cancs| |

Figure 3.2.5-1 Channel Gain Setup screen

Setting Item Channel Gain

Functional Outline Performs settings for each channel gain.

Setting Parameters Setting Range
DPCCH (Beta ¢) 0 (Switch Off) to 15 (1.0)
DPDCH (Beta d) 0 (Switch Off) to 15 (1.0)

Delta ACK (Beta hs/Beta c¢) 0 (5/15) to 8 (30/15)

Delta NACK (Beta hs/Beta 0 (5/15) to 8 (30/15)
¢

Delta CQI (Beta hs/Beta c) 0 (5/15) to 8 (30/15)

E-DPCCH (Beta ec/Beta c¢) 0 (5/15) to 8 (30/15)

E-DPDCH (Beta ed, k/Beta 0 (5/15) to 29 (168/15)
c)
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3.2 Uplink Setup Screen

(Cont’d)

Details Sets the gain of the channels for which On is set in the Uplink main screen,
according to the quantized waveform amplitude ratio.

In the Channel Gain Setup screen, the E-DPDCH channel gain displayed in
dB units indicates the total gain of all E-DPDCHs (e.g., total gain of two
E-DPDCHs when 2SF2 is selected). Note, however, the waveform amplitude
ratio does not match the value set in dB units if 2SF2, 2SF4, or
2SF2and2SF4 is selected for E-DPDCH Channel Codes, because the
waveform amplitude ratio to be set is for only one channel.

When 2SF2and2SF4 is selected for E-DPDCH Channel Codes, the waveform
amplitude ratio can be set for one E-DPDCH of SF4 (the value displayed in
dB units is a total gain of E-DPDCHs of SF2 and SF4).

When the OK button is clicked after applying settings to close the Channel
Gain Setup screen, the settings for each item are converted to [dB] units and
displayed in the Channel Edit screen.

When the Cancel button is clicked, the screen is closed without reflecting the
settings for each item on the Channel Edit screen.

3

suorjoun,f Jo uorpdrIosa(] parreroq
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Chapter 3 Detailed Description of Functions

3.2.6 Calculation screen

Clicking Calculation & Load, Calculation & Play, or the OK button on
the Export File dialog box will start the waveform generation.

The Calculation screen is displayed while a waveform pattern is being
generated. On this screen, the progress bar is displayed indicating the
generation process of the waveform pattern and the progress of the
waveform pattern generation. The generation of the waveform pattern
can be stopped by clicking the Cancel button. When cancelled, it returns
to the main screen.

Cresting Parameter File... -
Prog ress repo rt [ Generating Packets ] J

[ &djusting Level ]
111 Stream

Progress bar
‘\ij

Cancel button

Figure 3.2.6-1 Calculation Screen (In Progress)

After waveform pattern generation is finished, the message “Calculation
Completed.” is displayed in the progress window and the Cancel button
changes to the OK button.

When the generation is complete, you can return to the setting screen by
clicking the OK button. After waveform generation, two files with .wvi

and .wvd extension are output.

Creating Parameter Fils... ;I
[ Generating Packets |
[ Adjusting Lewvel |
111 Stream
[ Generating Mewy File |
111 Stream

Calculation Completed.

Figure 3.2.6-2 Calculation Screen (Completed)
Note:
When using this software on MG3710A, and selecting Calculation
& Load or Calculation & Play, the waveform generation ends

without displaying the above screen.
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3.2 Uplink Setup Screen

3.2.7 Calculation & Load

Note:
This function is available only when this software is used on
MG3710A.

When Calculation & Load is selected, the Load Setting screen will
display after waveform generation.

Load Setting 5 x|
~Wiave Pattemn
Package Hproducer
I:> SG1 / Memaryf
Pattern Name ‘WaveformPattern /

‘ OK / Cancel |

/

Button for selecting load destination /

Figure 3.2.7-1 Load Setting Screen

The Select Memory screen will display after clicking the load destination

in the Load Setting screen.

Select Memory. &l
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SG1
Memary A e mary B

G2

Memary A ‘ MemaryB ‘

QK Cancel ‘

Figure 3.2.7-2 Select Memory Screen

After selecting the load destination of generated waveform in the Select
Memory screen and clicking the OK button, the Load Setting screen will
be shown again. Click the OK button in the Load Setting screen, and

then the loading of waveform starts.

Notes:
e To exit this screen without loading the waveform pattern, click
the Cancel button in the Load Setting screen.
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e If the configuration of generated waveform pattern used two
memories, the Select SG screen displays just like Calculation &
Play.

3.2.8 Calculation & Play
Note:

This function is available only when this software is used on
MG3710A.

When Calculation & Play is selected, after waveform creation is

completed, the created waveform is loaded into memory, selected and

output.

When the 2nd Vector Signal Generator (option) is installed, the Select SG
screen is displayed before the start of waveform generation. This screen

1s used to select the signal generator for outputting the created waveform

pattern.

L se SG2 ‘

Figure 3.2.8-1 Select SG Screen

3.2.9 Saving/reading parameters

This numeric values and settings for each item can be saved in a

W Saving parameter file

parameter file by using this software.

When running on PC, MS2690A/MS2691A/MS2692A, or MS2830A

1.

Select Save Parameter File from the File menu or click the [%1
tool button to display the parameter file saving screen shown.

Enter a file name in the File name text box and click the Save
button to save the parameter file.

When the save destination is not changed in the Save in box, the
parameter file is saved in the following directory with the entered
file name:

X \IQproducer\HSDPAN\ Entered file name.prm

(“X:\IQproducer” indicates the folder where the IQproducer™ is
installed.)
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3.2 Uplink Setup Screen

savens 2(x|
Saven | ) HSDPA x|« &k Er

Daka U HID& pinit_M3269:x8.prm
DPCH_Paramn

Tmp

|®| HsDaDowninic, prm

Iﬂ HSDADowninik_MS269::4. prin

|®]HSDAUpinit. prm

File name: | Save I
Save at type: ISetting Filess [ prrn) =l Cancel |
%

Figure 3.2.9-1 Parameter file saving screen

When running on MG3710A (-?
. . . . . P
1. Click the Save Parameter File button in File menu or click the % &
[ Y
. . . e
button to display the parameter file saving screen. &
= )
Drives  |windows7 () - File Name | @
17}
[¢)]
x]
[=n
Directories File List g
=1Qproducer 2l [HSDADowninit prm = 5
1xEVDO FWD HSDADowninit MG3710A prm .'3
1 xEVDO_RVS HSDADowninit MS269xA. prm
AWGN - HSDADowninit_MS2830A.prm @]
HSDAUpinit.prm Iar)
CODF HSDAUpinit MG3710A prm S|
Clipping HSDAUpinit MS269xA.prm = [
Convert b
-DVB-TH Save to o
‘Fading C¥Anritsu¥ [QproducerFHSDPA¥ "—:,".
FFT )
S 5
-IQproducer wn
LTE
1 TF TNN x| Default Root OK Cancel

Figure 3.2.9-2 Parameter file saving screen (MG3710A)

2. Select the folder to store the file in the Directories field, and then
enter the name of the file using the File Name box. Click OK to save
the parameter file. To initialize the setting in the Directories field,
click the Default Root button.
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B Reading parameter file
When running on PC, MS2690A/MS2691A/MS2692A, or MS2830A
1. Select Recall Parameter File from the File menu or click the &
tool button to display the parameter file reading screen shown.

2. Select a parameter file to be read from the file list, and then click
the Open button to read the selected parameter file.

open 21x]
Look jn: | 5 HSD P& R I s ==

Daka Iﬂ H5DApinit_MS262:8. prm

|®]HSDADowririt.prm
B HSDADowninit_MS269x4. prm
|| HsDaUpinit.prm

File name: | Open I
Files of type: ISetting Files [*.pron) j Cancel |
VA

Figure 3.2.9-3 Parameter file reading screen

When running on MG3710A
1. Select Recall Parameter File from the File menu or click the &
tool button to display the parameter file reading screen.

Drives  windos? € -

Directories File List

IQproducer =" [HSDADowninit.prm 2

1xEVDO FWD HSDADowninit MG3710A prm
N HSDADowninit MS269xA prm
L);VE(\;NDO’RVS J HSDADOWninitiMS?SSOA,Erm
HSDAUpinit prm

cebr HSDALpinit MG3710A prm
GClipping HS DAUpinit MS269xA prm =l
‘Convert
-DVB-TH
Fading
FFT
IGproducer
LTE
1 TE TNN ~| Default Root OK Gancel

Figure 3.2.9-4 Parameter file reading screen (MG3710A)

2. Select the directory where the files to be loaded is stored in the
Directories field. Click the desired file from the File List, and click
OK.

To initialize the setting in the Directories field, click the Default
Root button.
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3.2.10 Generating waveform pattern file

A waveform pattern file to be used in the mainframe can be generated

based on the setting values.

The number of frames to be generated varies depending on the setting
conditions for each channel, and the time required for generating a

waveform pattern also varies accordingly.

<Procedure>
1. Select Calculate Waveform Pattern from the Edit menu or click the
Wl | tool button.

At this time, the Warning message shown below appears when the
total power is not normalized by clicking the Normalize Power button.

Wlarning

Tatal channel power iz not normalized to 0 dB.
It i necessary to normalize the total power when Simulation iz UpLink.

Cancel |

Figure 3.2.10-1 Warning message
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Click the OK button to normalize the Total Power and proceed with the
next step. :

g
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2. The file name input screen is displayed.

File name display area testwvi
Ntestwvd

Output destination folder
selection button

Output File Name x|
Expart Path
|)0rp0ration¥8ignal finalvzer¥System¥Wavetor mEHSUP &_Uplink _I

Package

Package name input box____—SUPAUplink

Cutput File Mame

Output file name input box____—est

Comment

Comment input box___—t

|
RRC Filter Off checkbox___—F RRG Filter Off

Cancel _|

Figure 3.2.10-2 File name input screen

Enter a package name in the package name input box, up to 31

characters.

Enter a file name in the file name input box, up to 20 characters

1-byte alphanumeric characters and the following symbols can be

used for a file name:

%&O+="1_-~@l]

When a file name is entered, the file to be generated is displayed in

the file name display area in the following format:

File name format:

test.wvi

‘—) Extension: wvi... Information file (text format)

wvd... Data file (binary format)

Entered file name

Enter a comment for the waveform pattern in a comment input box.

Three comment input boxes are provided, and a comment can be

entered in each line within 38 characters.
1-byte alphanumeric characters and symbols can be used for
comments.

The contents of each comment are displayed on the screen when the

corresponding waveform pattern is selected by the Vector Signal

Generator. Leave the comment boxes blank if not necessary.
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3.2 Uplink Setup Screen

When the RRC Filter Off check box is selected, symbol data that
does not pass through the RRC filter is generated as a waveform
pattern. This check box needs not be selected under normal

conditions.

Click OK on the Export File screen. The Calculation screen shown in
Figure 3.2.6-1 is displayed and waveform pattern generation starts
(the output destination folder, package name, and file name must be

set to start waveform pattern generation).

When started with MS269x or MS2830A and when MS269x or
MS2830 is selected in the Select instrument screen, waveform
pattern files generated by this application are saved in the following
directory:

C:\Program Files\Anritsu Corporation\Signal
Analyzer\System\Waveform

When used with MG3710A, the files are saved in the following
directory:

C\Anritsu\MG3710A\User Data\Waveform

In other cases, clicking the output destination selection button
displays the Browse for Folder screen shown in Figure 3.2.10-3. The

output destination folder can be selected from this screen.

Select Folder

H-05) 1xEVDO_FWD -]
B3 1xEVDO_RYS
~{03) AwGH
{3 CCoF J
F-T) Convert
-{3) DVB-T_H
= Ll
[=1-5) HSDPA
] [t

..... i) Tmp
- d T resa hal
1| | »

K I Cancel |

Figure 3.2.10-3 Browse for Folder screen
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Chapter 3 Detailed Description of Functions

3.2.11 Auxiliary signal output

When a waveform pattern generated by this software is selected by the
mainframe, a marker signal synchronized with the RF signal is output
from the AUX input/output connector of the rear panel as an auxiliary

signal. Frame Pulse (Connector 1) is output.

e Frame Pulse
10 ms cycle pulse synchronized with the symbol at the beginning of
the frame is output from Connector 1. The signal polarity can be
changed by changing the polarity of Marker 1.

3-88.



Chapter 4 How to Use Waveform Patterns

The following operations are required to output a modulated signal from
this equipment using the waveform pattern generated by this software:

e Transferring waveform pattern to internal hard disk
e Loading waveform patterns from the hard disk to the waveform
memory

e Selecting a waveform pattern to be output from this equipment

This chapter explains the details of these operations.

4.1  For MG3700A or MG3710A......cccoiiieeeeiee e 4-2
4.1.1 Transferring waveform pattern to internal

hard disk ..o 4-2

4.1.2 Loading to Waveform Memory ...................... 4-4

4.1.3 Selecting Waveform Pattern...............c.c........ 4-5

4.2 For MS2690A/MS2691A/MS2692A or MS2830A......4-6
4.2.1 Transferring waveform pattern to internal

hard disk ... 4-6
4.2.2 Loading to Waveform Memory .............c........ 4-6
4.2.3 Selecting Waveform Pattern.......................... 4-7
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Chapter 4 How to Use Waveform Patterns

41 For MG3700A or MG3710A

This section describes how to download a waveform pattern created for
the MG3700A/MG3710A to the hard disk of the MG3700A/MG3710A and
output the pattern.

4.1.1 Transferring waveform pattern to internal hard disk

The waveform pattern created with this software can be transferred to
the internal hard disk in the following ways:

Note:
This operation is not necessary if you are using MG3710A and
have generated waveform patterns on MG3710A.

For MG3700A
e LAN
e CompactFlash Card

For MG3710A
e LAN

e External device such as USB Memory

m Transferring from PC via LAN (MG3700A, MG3710A)
Two IQproducer™ tools can be used to transfer a waveform pattern to
the MG3700A/MG3710A via a LAN.

e Transfer & Setting Wizard
Start this wizard by clicking the Transfer & Setting Wizard button of
this software or by selecting Simulation & Utility tab — Transfer &
Setting Wizard from the IQproducer™ after creating a waveform
pattern. For details, refer to Section 4.7 “File Transfer and Loading to
Memory Using Transfer & Setting Wizard” in the
MG3700A/MG3710A Vector Signal Generator MG3740A Analog
Signal Generator Operation Manual (IQproducer™).
Transferring a waveform pattern to the internal hard disk of the
MG3700A/MG3710A, loading the waveform from the hard disk to the
waveform memory, and then outputting the waveform pattern can be
done using this wizard.




4.1 For MG3700A or MG3710A

e Transfer & Setting Panel
This function is loaded by selecting Transfer & Setting Panel in the
Simulation & Utility tab of the IQproducer™. For details, refer to
Section 5.2 “Transferring Waveform Pattern” in the
MG3700A/MG3710A Vector Signal Generator MG3740A Analog
Signal Generator Operation Manual IQproducer™.
Specify the folder that contains the waveform pattern to transfer to
the MG3700A/MG3710A in the PC-side tree of Transfer & Setting
Panel.

m Transferring using a CF card (MG3700A)
Copy the waveform pattern (*** wvi and ***.wvd files) to be downloaded
to the MG3700A to the root directory of a CF card.

Insert the CF card into the card slot on the front panel of the MG3700A,
and then copy the file to the hard disk. For details about how to use a CF
card to transfer a waveform pattern, refer to (1) Loading waveform file in
memory in Section 3.5.2 of the MG3700A Vector Signal Generator
Operation Manual (Mainframe).

m Transferring via external device such as USB memory (MG3710A)

For details about how to transfer a waveform pattern created using this
software to the hard disk of the MG3710A, refer to Section 7.3.6 “Copying
external waveform pattern: Copy” in the MG3710A Vector Signal
Generator MG3740A Analog Signal Generator Operation Manual
(Mainframe).
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41.2 Loading to Waveform Memory

To output a modulated signal using a waveform pattern, it is necessary to
load the waveform pattern that was transferred to the internal hard disk
of the MG3700A/MG3710A (described in Section 4.1.1 “Transferring
waveform pattern to internal hard disk”) to the waveform memory. A
waveform pattern can be loaded into the waveform memory in the
following two ways.

m Configuring using the mainframe
A waveform pattern can be loaded into the waveform memory by using
the instruction panel of the MG3700A/MG3710A or by using a remote

command.
For operation using the front panel, refer below:

e Section 3.5.2 (1) “Loading waveform file in memory” in the MG3700A
Vector Signal Generator Operation Manual (Mainframe)

e Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A
Vector Signal Generator MG3740A Analog Signal Generator
Operation Manual (Mainframe)

For operation using remote commands, refer below:

e Chapter 4 “Remote Control” in the MG3700A Vector Signal
Generator Operation Manual (Mainframe)

e Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A
Vector Signal Generator MG3740A Analog Signal Generator
Operation Manual (Mainframe)

m Using Transfer & Setting Panel of IQproducerTM

A waveform pattern can be loaded from the LAN-connected PC to the
memory by using Transfer & Setting Panel, which can be opened from
the Simulation & Utility tab. For details, refer to Section 4.6 “File
Transfer and Loading to Memory Using Transfer & Setting Panel” in the
MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal
Generator Operation Manual (IQproducer™).
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4.1.3 Selecting Waveform Pattern

Select a waveform pattern to use for modulation from the waveform
patterns loaded into the waveform memory of the MG3700A/MG3710A
according to Section 4.1.2 “Loading to waveform memory”. A waveform

pattern can be selected in the following two ways.

m Configuring using the MG3700A/MG3710A
Waveform patterns to be used for modulation can be selected by

operating the equipment panel or by using a remote command.
For operation using the front panel, refer below:

e Section 3.5.2 (4) “Outputting pattern loaded in Memory A for
modulation in Edit mode” in the MG3700A Vector Signal Generator
Operation Manual (Mainframe)

e Section 7.3.5 “Selecting output waveform pattern: Select” in the
MG3710A Vector Signal Generator MG3740A Analog Signal
Generator Operation Manual (Mainframe)

For operation using remote commands, refer below:

e Chapter 4 “Remote Control” in the MG3700A Vector Signal Generator
Operation Manual (Mainframe)

e Section 7.3.5 “Selecting output waveform pattern: Select” in the
MG3710A Vector Signal Generator MG3740A Analog Signal
Generator Operation Manual (Mainframe)
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m Using Transfer & Setting Panel of IQproducerTM

A waveform pattern can be loaded from the LAN-connected PC to the
memory, and also selected for modulation. This is done by using Transfer
& Setting Panel, which can be opened from the Simulation & Utility tab.
For details, refer to Section 4.6 “File Transfer and Loading to Memory
Using Transfer & Setting Panel” in the MG3700A/MG3710A Vector
Signal Generator MG3740A Analog Signal Generator Operation Manual
(IQproducer™).
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4.2 For MS2690A/MS2691A/MS2692A or MS2830A

This section describes how to download a waveform pattern created for
the MS2690A/MS2691A/MS2692A or MS2830A to the hard disk of the
MS2690A/MS2691A/MS2692A or MS2830A and output the pattern.

4.2.1 Transferring waveform pattern to internal hard disk

For details about how to transfer a waveform pattern created using this
software to the hard disk of the MS2690A/MS2691A/MS2692A or
MS2830A, refer below:

e Section 2.4.4 “Copying waveform file(s) to hard disk” in the
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector
Signal Generator Operation Manual (Operation)

e Section 2.4.4 “Copying waveform file(s) to hard disk” in the MS2830A
Signal Analyzer Vector Signal Generator Operation Manual
(Operation)

Note:
Transferring waveform patterns is not required if the patterns are
created using this software.

4.2.2 Loading to Waveform Memory

In order to output a modulated signal using the waveform pattern, it is
necessary to load the waveform patterns stored in the internal hard disk
to the waveform memory.

m Loading to Waveform Memory
Waveform patterns can be loaded to waveform memories by operating the

panel or by using a remote command.
For operation using the front panel, refer below:

e Section 2.4.1 “Loading waveform file in memory” in the
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector
Signal Generator Operation Manual (Operation)

e Section 2.4.1 “Loading waveform pattern(s) to memory” in the
MS2830A Signal Analyzer Vector Signal Generator Operation
Manual (Operation)
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For operation using remote commands, refer below:

e MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector
Signal Generator Operation Manual (Remote Control)

e MS2830A Signal Analyzer Vector Signal Generator Operation
Manual (Remote Control)

4.2.3 Selecting Waveform Pattern
Select waveform patterns to be used for modulation from those loaded in
the waveform memory as described in Section 4.2.1 “Transferring
waveform pattern to internal hard disk” above.

m Selecting waveform pattern
Waveform patterns to be used for modulation can be selected by
operating the equipment panel or by using a remote command.

For operation using the front panel, refer below:

e Section 2.4.2 “Loading waveform file in memory” in the
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector
Signal Generator Operation Manual (Operation)

e Section 2.4.2 “Loading waveform pattern(s) to memory” in the
MS2830A Signal Analyzer Vector Signal Generator Operation
Manual (Operation)

For operation using remote commands, refer below:
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e MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector
Signal Generator Operation Manual (Remote Control)

e MS2830A Signal Analyzer Vector Signal Generator Operation
Manual (Remote Control)
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Appendix A FError Messages

A list of error messages is shown below.

Table A-1 Error messages

Error Message

Description

Initialization error

An application initialization error occurred.

Selection of an inaccurate file. (“ File name’)

The selected file type (waveform file) is invalid.

Can not open file. (“File name”)

The file cannot be opened.

Invalid file format. (“ File namé”’)

The contents of the selected file (waveform
information file) are invalid.

The data of a Wave-form file is unusual.

The waveform pattern data is abnormal.

Can not write file. (“File name’)

A file writing error occurred.

Can not read file.

A file reading error occurred.

An “IQproducer” is down.
Application is shutdown.

The application is exited since a platform
abnormal error occurred.

Can not open the parameter file. (“File nameé’)

A setting file reading error occurred.

The Setting value is invalid Parameter name.

An invalid setting value error occurred.

The Setting value is out of range. “(Parameter
name (minimum value — maximum value))”’

An out-of-range setting value error occurred.

Total channel power except OCNS is over 0 dB.

A total power error occurred.

Channelization Code Conflicted.
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An orthogonal warning occurred.

An 1nitial parameter file was not able to be read.

An 1initial parameter file error occurred.

PN9 for HSDPA channels cannot be selected
when the Process Cycle is more than 6, change
the data except PN9.

A process cycle setting error occurred.

All Channels are OFF.

V X1pueddy

All channels are OFF.

Input File Name.

Input a file name.

Value is set up at 800 steps.

A setting unit error occurred.
* 800 is set as a setting unit, for example.

Process Setting File read error. (“File name’).

A process file reading error occurred.

Pattern Setting File read error. (“File name”).

A pattern file reading error occurred.

DTCH information data is changed to the data
truncated every one frame (PN9fix).

A DTCH information change warning is alerted.

Payload Information Data for HS-DSCH or
Data for HS-SCCH/HS-PDSCH is changed
to the data truncated every subframe (PN9fix).

A HS-SCCH/HS-PDSCH information change
warning is alerted.

Total channel power is not normalized to 0 dB.
It is necessary to normalize the total power when
OCNS is OFF.

A warning is alerted that normalization is not
executed.

Total channel power is not normalized to 0 dB.
It is necessary to normalize the total power when
Simulation is UpLink.

A warning is alerted that normalization is not
executed.

Channel Edit Parameters are invalid.

The parameters on the Channel Edit screen are
invalid.

Channel Gain Setup Error.

The parameters on the Channel Gain Setup
screen are invalid.
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Table A-1 Error messages (Cont’d)

Error Message Description
DPCH information is changed to the data DPCH information was changed from PN9 to
truncated every one frame (PN9fix). PN9fix.

TrCH data is changed to the data truncated every

one frame (PNOfix). TrCH data was changed from PN9 to PN9fix.

DPCH Data and TrCH data is changed to the DPCH information and TrCH data were changed
data truncated every one frame (PN9fix). from PN9 to PN9fix.

An illegal value is set in the HARQ process

The ‘parameter name'of CSV file is invalid. . .
setting file.

The Information Bit Payload value set in the
HARQ process setting file is too large with
respect to the E-DPDCH Ch Codes setting value.
Adjust the Information Bit Payload value
according to the Information Bit Payload
maximum value list that will be displayed along
with the error message.

The ‘Information Bit Payload' is too large for
‘E-DPDCH Ch Codes.’

The memory option is not available for the
IQproducer™ for MS269x.

Memory option cannot be turned on in MS269x Note:

mode. This message is available only when MS269x is
selected in the Select instrument screen  at
startup.
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B.1 For MG3700A and MG3710A

The MG3700A and MG3710A has two arbitrary waveform memories from which dif-
ferent waveform patterns can be output separately. It is possible to add two signals,

such as a desired signal + AWGN, using the baseband to be output as one RF signal.

Note:

If MG3710A is used as a mainframe and if adding two signals at
baseband and outputting as one RF signal, the combination of
baseband signal option must installed.

When using the memories A and B individually as is in a normal case,
however, the memory length may not sufficient for handling a waveform
pattern with a long period that is used in a reception test. (A long-period
waveform pattern may be caused as a result of the settings for SFN in-
cluded in BCH, or the settings for HARQ Process Cycle when [PN9]] is
selected for the DCH data type.)

This problem may be resolved by using the capacities of both memories A

and B to generate a waveform pattern. This is available by switching

>
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memories A and B alternately as shown in Figure B.1-1 below. Note,

however, that it is not possible to add two signals such as AWGN and in-

terference signals in this event. g:b
%
Memory (A) R
>
7L|_ o
o-<p| pac >
Memory (B) 74’_

Figure B.1-1 Pattern Using FIR filter

If enough data length is still not obtained though the above memory con-
figuration is configured, use the function to execute filtering processing
using the FIR filter of the hardware incorporated in the MG3700A as
shown in Figure B.1-2. If a waveform pattern that is filtered at data
generation exceeds the total capacity of the arbitrary memories A and B,
this hardware filtering function is used to automatically generate the

waveform pattern.

However, waveform patterns used in this configuration are not applicable
for interference signals because the number of taps of the FIR filter is
less than the normal waveform pattern.

Moreover, it is also not possible to add two signals such as AWGN and

interference signals in this event.
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Memory (A) Filtered data
= P-CCPCH /’
FIR filter 74’ DAC 7L>
Memory (B)
= SCH, CPICH, Chip data
DPCH, etc. (3.84Msample/s)

Figure B.1-2 Block Diagram with FIR Filter Used

Table B.1-1 below lists the maximum number of frames in each memory
configuration.

Table B.1-1 Maximum Number Of Generatable Frames For Each Condition:

MG3700A
Addition of
ARB Memory . Max. No.of | AWGN and
Expansion FIR Filter Used Memory
. Frames Interference
Option !
Signal
Not d AorB 2330 Enabled
ot use :
Installed A&B 1662(’)7 — Disabled
Used A&B B: 6990 Disabled
Not d AorB 1165 Enabled
ol use K
Not installed A&B 12;'33103981 Disabled
Used A&B B: 3495 Disabled

Table B.1-2 Maximum Number Of Generatable Frames For Each Condition
(Without ARB Memory Expansion Option): MG3710A

Addition of
Combination of Base- . Max. No. of AWGN and
band Signal Option FIR Filter Used Memory Frames Interference
Signal
Not d AorB 582 Enabled
ovuse A&B 1165 Disabled
Installed A 6990
d A&B ' Disabled
Use & B 1747 isable
Not used - 1747 Disabled
Not installed
obinstatie Used : 582 Disabled
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Table B.1-3 Maximum Number Of Generatable Frames For Each Condition (With
ARB Memory Expansion 256M sample or ARB Memory Expansion 1024M sam-

ple): MG3710A

Addition of
Combination of Base- . Max. No. of AWGN and
band Signal Option FIR Filter Used Memory Frames Interference
Signal
Not d AorB 2330 Enabled
oruse A&B 4660 Disabled
Installed A 27969

Used A&B B: 6990 Disabled

. Not used 6990 Disabled

Not installed Used 2330 Disabled

>
°
°
0]
>
o
X

q xtpueddy



Appendix B Number of Frames to Be Generated

B.2 For MS2690A/MS2691A/MS2692A or MS2830A

Table B.2-1 shows the number of frames that can be generated.

Table B.2-1 Maximum Number of Frames That Can Be Generated

RRC Filter Max. No. of Frames
On (normal setting) 2330
Off 6990
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